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Overview 
This guide provides instructions on how to install and configure the Analysis Cubes and 
Performance Dashboards components of the Deltek Vision 7.6 Performance Management 
module. These instructions apply for both the Performance Management edition and the 
Performance Management Analysis Cubes edition of the Performance Management module. 
These instructions also apply for both new Vision 7.6 Performance Management installations and 
upgrades from earlier versions. 

Performance Management Editions 
Performance Management is an optional module that comes in two editions: 

 Vision Performance Management Edition 
This edition contains the Analysis Cubes, Performance Dashboards, and Visualization 
components: 

 Analysis Cubes — This provides you with a Vision project data cube and a general 
ledger data cube from which you create custom Vision reports with Microsoft Excel® 
or any business intelligence tool that supports SQL Server Analysis Services OLAP 
cubes. The Analysis Cubes also serve as the data sources for the performance 
dashboards that you create. 

 Performance Dashboards — Use Tableau® Server and Tableau Desktop (products 
of Tableau Software®, Inc.), along with Vision Analysis Cubes and Microsoft SQL 
Server Analysis Services components, to create role-based graphical performance 
dashboards. Performance dashboards are business intelligence tools that executives 
and managers use to view and interact with critical project and general ledger data 
using a variety of graphical representations of that data. The performance 
dashboards are displayed as dashparts on the Vision Dashboard. 

Vision Performance Management provides a set of sample performance dashboards, 
created using the Tableau software, that you can use as examples of the capabilities 
of performance dashboards and as a starting point for building your own performance 
dashboards. Each set is designed for a specific management and responsibility role 
in your firm, from corporate executives to project managers. 

 Visualization — The Visualization feature in Vision Performance Management is a 
visual data analysis tool with interactive graphics. Visualization enables you to 
display key metric values for your projects, project plans, and opportunities in a 
graphical format to help you analyze performance, determine trends, and identify 
risks to your business. You can bring together metrics with different scales and time 
periods, and you can quickly switch the focus from one metric to another. 

 

Visualization is installed automatically as part of the Vision installation process. It 
does not have a separate installation procedure. 
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 Performance Management Analysis Cubes Edition 
This edition contains only the Analysis Cubes component: 

Analysis Cubes — This provides you with a Vision project data cube and a general 
ledger data cube from which you create custom Vision reports with Microsoft Excel® or 
any business intelligence tool that supports SQL Server Analysis Services OLAP cubes. 

If You Have a 6.x Version of Analysis Cubes Installed 
Analysis Cubes became part of the Performance Management module in the Vision 7.0 release. 

If you have a 6.x version of Analysis Cubes installed: 

 To access the new features for Analysis Cubes in Vision 7.6, you must purchase 7.6 
Performance Management or Performance Management Analysis Cubes. 

 If you install Vision 7.6 but you do not purchase 7.6 Performance Management or 
Performance Management Analysis Cubes, you still have access to the same 
functionality and features that you had in your 6.x Analysis Cubes deployment. 
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Adding Custom Notes to This Guide 
If you would like to add custom notes to this guide that are specific to your company, Adobe® 
Reader® X provides this ability. If you do not already use Adobe Reader X, you can download it 
here free from Adobe. 

To add a custom note using Adobe Reader X, complete the following steps: 
1. On the Reader toolbar, click Comment at the far right. 

2. In the Annotations pane that displays, click  Sticky Note. The cursor changes to 
match the button. 

3. Position the cursor at the location in the guide where you want the note to appear, and 
click. A note icon is inserted at the location and a text box pops up. 

4. Enter your information in the text box. 

5. Continue adding notes as needed. 

6. Save the document. 

 

Deltek recommends that you save the document to a slightly different file name to keep the 
original file from being overwritten. 

When reading the document, cursor over a note icon to see the information. Double-click a note 
icon to edit the information. 

http://get.adobe.com/reader/
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If You Need Assistance 
If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 
For over 20 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP). 

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and hot fixes 

 

If you need assistance using the Customer Care Connect site, the online help available on the 
site provides answers for most questions. 
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  
1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you do not have a username and password for the Customer Care Connect site, contact your 
firm’s Vision Administrator. 

If you forget your username or password, you can click the Account Assistance button on the 
login screen for help. 

Additional Documentation 
The following table lists additional related Deltek documentation that is available for this release. 
These documents are available for download from the Deltek Customer Care Connect site. 

Document Name Description 

Deltek Vision 7.6 Release Notes These release notes contain pre-installation information, 
database changes, and a summary of enhancements 
and software issues resolved in the Vision 7.6 release. 

Deltek Vision 7.6 Performance 
Management Content and 
Functionality Overview 

This guide provides an overview of Vision Performance 
Management functionality and the pre-built visualizations 
that are included with it. 

Deltek Vision 7.6 Technical 
Installation Guide 

This guide contains detailed instructions for installing all 
the technical components of Vision, including the 
servers, the database, and the application itself. 

Deltek Vision 7.6 Advanced 
Technical Administration Guide 

This guide provides IT staff and system administrators 
with instructions for installing and configuring advanced 
technical components of Vision. 

Deltek Vision 7.6 Custom 
Reports and Microsoft SQL 
Server Reporting Services 

This guide provides instructions to create, deliver, and 
generate Vision custom reports with Microsoft SQL 
Server Reporting Services and its report writing tools. 

Deltek Vision 7.6 Microsoft SQL 
Server Reporting Services 
Licensing FAQ 

This guide explains the Microsoft SQL Server Reporting 
Services licensing implications for Vision. 

Tableau® Server 9.3 
Administrator Guide 

This administrator guide, produced by Tableau 
Software®, Inc., is a complete reference for handling 
administrative tasks on Tableau Server. Use Tableau 
Server and Tableau Desktop, along with Vision Analysis 
Cubes and Microsoft SQL Server Analysis Services 
components, to create role-based graphical performance 
dashboards. 

http://support.deltek.com/
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Chapter 1: Analysis Cubes Prerequisites and 
Installation 

Analysis Cubes Prerequisites 
The following prerequisites must be met before you configure and use Vision Analysis Cubes: 

 .NET Framework  
 The Resource Kit requires that the .NET Framework version 3.5.1 and version 4.5.2 

be installed on the database server. 

 Microsoft SQL Server 
 You must have Microsoft SQL Server 2016, 2014 or 2012 installed.  SQL Server 

2016 is newly supported for Vision 7.5 and 7.6 with the October 2016 Cumulative 
Update. 

 Windows Server 2008/ 2008 R2 and SQL Server 2008/2008 R2 are no longer 
supported with Deltek Vision. 

 The Standard, Business Intelligence or Enterprise edition of SQL Server must be 
installed. These editions provide you with the required SQL Server Analysis Services.   

 For a full list of Microsoft SQL Server releases (R), service packs (SP), and 
cumulative updates (CU) that Vision supports, see the Deltek Product Support 
Compatibility Matrix. You can download this at the Deltek Customer Care Connect 
site. 

 

Service packs for Microsoft SQL Server that Vision supports must be installed 
after Analysis Services is installed. If you already installed the service pack and 
you still need to install Analysis Services, install Analysis Services, and then 
reinstall the service pack. 

 Microsoft SQL Server Analysis Services 
You must have Microsoft SQL Server Analysis Services (a component of SQL Server) 
installed. Vision only supports the Multidimensional (not Tabular) mode. 

 Microsoft SQL Server Integration Services 
You must have SQL Server Integration Services installed. This is a shared component of 
the SQL Server. 

 Microsoft SQL Server Availability Groups  
If you will be deploying Vision Analysis Cubes in a configuration which includes Microsoft 
SQL Availability Groups there are specific steps required in the setup as well as specific 
failover requirements. Please refer to the chapter on Availability Groups in the Deltek 
Vision Advanced Technical Administration Guide for additional information. 

 Active Directory Domain Environment 
You must have an Active Directory domain environment. Your Analysis Cubes clients and 
database server must be members of the domain. 
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 Vision Database Tier Installation 
The database tier of the Vision installation must be run on your database server. This is 
necessary so you can access the Vision Resource Kit and configure the environment for 
Analysis Cubes. If you are upgrading from a previous version of Vison, you must upgrade 
your existing installation on the database server as well as rebuilding the cubes.  

After the initial Vision database tier installation, you must reboot your database server 
before you configure the Analysis Cubes. This is necessary so that the environment 
variables that are created during the installation are registered properly. Upgrades of 
Vision do not require that you reboot the database server. 

 Scaling out your Analysis Cubes Deployment 
A default configuration of Analysis Cubes creates all components (Data Warehouse, 
Integration Services packages (ETL logic) and the Analysis Cube on the same server 
hosting your Vision database. It is possible to setup your Analysis Cubes configuration 
where the Data Warehouse, Integration Services Packages (ETL Logic) and Analysis 
Cubes exist on one or two different servers thus freeing up the primary database server 
of the resource intensive tasks of refreshing the Analysis Cube data. The process to 
create a scalable analysis cube configuration is outlined in Appendix B of this guide. This 
process involves many manual steps and will also require additional SQL Server 
licenses. 

 

 

Deltek provides OLAP (online analytical processing) services to assist you with the installation, 
configuration, and optimization of your SQL Analysis Cubes. These services consist of 
consulting, Web conferencing and training, installation guides, and reporting assistance.  

For more information, please contact your Deltek account manager at 
accountmanager@deltek.com. 

Microsoft SQL Server Edition Dependencies 
Some Analysis Cubes functionality works only if you have Microsoft SQL Server Enterprise 
Edition or the newly supported Business Intelligence Edition installed. 

If you are using the Standard edition, the following items are not included in the Analysis Cubes 
and Vision because the Standard Edition does not support semi-additive measures. 

Dimensions and Measures 
Dimensions and measures that are not included in the data cubes if you use SQL Server 
Standard Edition are: 

 Presentation Currency 

 All the dimensions in the Presentation Currency dimension group in the Project and 
General Ledger data cubes.  

 Accounts Receivable Trending 

 All the measures in the AR Trending measure group (including the measures in the 
Multicurrency subfolder) in the Project data cube. 

 Days Sales Outstanding (DSO) 

 The DSO 90 and DSO 360 measures in the Accounts Receivable measure group in 
the Project data cube. 

mailto:accountmanager@deltek.com
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 The DSO 90 in Billing Currency and DSO 360 in Billing Currency measures in the 
Multicurrency folder in the Accounts Receivable group. 

 The DSO 90 in Project Currency and DSO 360 in Project Currency measures in the 
Multicurrency folder in the Accounts Receivable group. 

 Days Work-In-Progress Outstanding (DWO) 

 The DWO 90 and DWO 360 measures in the Unbilled folder in the Values group in 
the Project data cube. 

 The DWO 90 in Billing Currency and DWO 360 in Billing Currency measures in the 
Unbilled – Multicurrency folder in the Values group in the Project data cube. 

 The DWO 90 in Project Currency and DWO 360 in Project Currency measures in the 
Unbilled – Multicurrency folder in the Values group in the Project data cube. 

Currency Exchange 
The Currency Exchange tab in Vision Configuration » General » Analysis Cubes does not 
display if you use SQL Server Standard Edition. 

Key Performance Indicators (KPIs) 
The following Deltek-provided KPIs are not available if you use SQL Server Standard Edition:  

 DSOTargetPrincipal 

 DSOTargetOrg1 

 DSOTargetProject Manager 

 DSOTargetNoDimension 

 DWOTargetPrincipal 

 DWOTargetOrg1 

 DWOTargetProject Manager 

 DWOTargetNoDimension 

Microsoft SQL Server ─ Important Information 
The following information applies for all supported editions for the core database and Analysis 
Services requirements of Vision. 

Multi-Dimensional Mode for Analysis Services 
Analysis Cubes supports only the installation of the standard multi-dimensional mode for Analysis 
Services. It does not support the new tabular mode introduced with SQL Server 2012 and later 
versions. 

Microsoft SQL Server Collation and Database Compatibility Level Settings 

Database Compatibility Level 
The Data Warehouse (DW) database will be created using the Compatibility Level of the Model 
database, which should match the version of the SQL Server (for example, 110 for SQL 2012, 
120 for SQL 2014 and 130 for SQL 2016). You should ensure that the Compatibility Level of your 
Vision database matches the Data Warehouse database.  
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You can validate the Compatibility Level on the Options page of the Database properties, using 
SQL Server Management Studio. 

SQL Server Collation 
The Data Warehouse (DW) database will be created using the Collation of the Vision database.  
This may or may not match the SQL Server Collation settings. The Analysis Services Database 
will be based on the Collation of the Analysis Server. If you receive “Cannot resolve collation 
conflict” errors during the SQL Agent refresh job processing, ensure that the Collation settings of 
the Vision database, Data Warehouse, and Analysis Services match.  

You can validate the Collation settings of the SQL Server databases on the Options page of the 
Database properties, using SQL Server Management Studio. You can validate the Analysis 
Services Collation settings on the Language/Collation page of the Analysis Services properties 
using SQL Server Management Studio. 

Service Accounts and Permissions 
When you installed Microsoft SQL Server, if you used the default service accounts that were 
provided, the local service accounts for all SQL Server services that were configured 
automatically do not have the necessary rights to perform some of the required steps to build 
Analysis Cubes. The following sections describe the service accounts that you need to 
reconfigure to be able to build Vision Analysis Cubes. 

SQL Server Analysis Services Service Account 
The SQL Analysis Services service account must have db_owner rights to the Vision data 
warehouse database. If it does not have these rights, the SQL Agent refresh job that you perform 
in Steps 4 & 6: Populate DW and Vision Cubes in the Resource Kit will fail after it runs for a 
long period of time. For instructions on how to fix this, see the “Reconfigure the SQL Server 
Analysis Services Service Account” section of this guide on page 21. 

SQL Server Agent Service Account 
The SQL Server Agent service account must be a member of the Analysis Services Administrator 
Role which is configured via the Analysis Services properties, Security page. If the account does 
not have rights to Analysis Services, the Refresh Job will fail. 

In addition, when you installed Microsoft SQL Server, if you used the default service accounts 
that were provided, the SQL Server Agent Refresh Job account does not have the necessary 
rights to the file system on the server, so the Analysis Cubes detailed output log will not be 
created. 

For more information about how to fix this, see the “Enable the SQL Agent Job Detailed Output 
Log” section on page 34. 

Error Running SQL Agent Refresh Job on Multi-Instance Servers 
The SQL Agent refresh job will fail when both of the following apply: 

1. You installed SQL Server 2012 or SQL Server 2014 on a server as a second SQL 
instance. 

2. The other instance of SQL was installed first and is an earlier version of SQL Server (for 
example, SQL Server 2008 R2). 
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This problem is not evident if the instances are SQL Server 2012 and SQL Server 2014. 

The SQL Agent job will fail because the dtexec.exe process that runs the job is being called from 
the previous SQL version instance because the SQL 2012 path to dtexec is listed second in the 
System PATH variable. 

To prevent this issue, do either of the following: 

1. Modify the SQL Agent refresh job to include the fully qualified path to the SQL 2012 
version of dtexec. 

Fully qualified path dtexec for SQL 2012:  

C:\Program Files\Microsoft SQL Server\110\DTS\Binn 

Example: 

"C:\Program Files\Microsoft SQL Server\110\DTS\Binn\dtexec.exe" /F "C:\Program 
Files\Deltek\Vision\Analysis\ETL_2K8\Jobs\Vision_Cubes_en-
US\Vision_ETL_Master_Package.dtsx" /Conf "C:\Program 
Files\Deltek\Vision\Analysis\ETL_2K8\Jobs\Vision_Cubes_en-
US\VisionETL_Config.dtsconfig" 

2. Change the path variable in Advanced System Settings on the server so that the SQL 
2012 path(s) are listed first. 

Install Vision Analysis Cubes and the Resource Kit 
When you run the installation routine on your database server to install or upgrade your Vision 
software, the Vision Analysis Cubes components and the Resource Kit (required to configure 
Analysis Cubes) are installed and updated automatically. After these are installed, a system 
administrator uses the Resource Kit, Vision, and Microsoft SQL Server Management Studio to 
configure Analysis Cubes. 

Important Update for Vision 7.6 Cumulative Update 24 
With the release of CU 24 for Vision 7.6 the Resource Kit now utilizes SQLCMD to execute 
database scripts (previously this was done via OSQL.exe).  This change was made due to 
compatibility issues with the recommendation to disable the TLS 1.0 (deprecated security 
protocol) as the OSQL application is not TLS 1.1/1.2 compliant. 

CU 24 must be installed on the database server as well as the application server.  You must 
rebuild Vision Analysis Cubes once this CU is installed. 

Additionally, based on your version of SQL Server, you may not have the (x86) version of 
SQLCMD.exe installed.  Below are the links where you can download the necessary installation 
from Microsoft: 

SQL 2012 SP4 Feature Pack: https://www.microsoft.com/en-us/download/details.aspx?id=56041 

 Select the Download button 

 Check the box for (ENU\x86\SqlCmdLnUtils.msi) and click next to download 

 Run the installer on the database server 

 

SQL 2014 SP2 Feature Pack: https://www.microsoft.com/en-us/download/details.aspx?id=53164 

https://www.microsoft.com/en-us/download/details.aspx?id=56041
https://www.microsoft.com/en-us/download/details.aspx?id=53164
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 Select the Download button 

 Check the box for (ENU\x86\MsSqlCmdLnUtils.msi) and click next to download 

 Run the installer on the database server 

 

SQL 2016/2017 – should be installed by default. 

The Resource Kit will check for SQLCMD.exe in the following locations: 

SQL 2012: c:\program files (x86)\Microsoft SQL Server\110\Tools\binn 

SQL 2014: c:\program files (x86)\Microsoft SQL Server\Client SDK\ODBC\110\Tools\Binn 

SQL 2016 (and higher): c:\program files (x86)\Microsoft SQL Server\Client 
SDK\ODBC\130\Tools\Binn 

 

If you do not have SQLCMD installed you will receive a message similar to the following: 
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Chapter 2: Configure Analysis Cubes 
You must complete the steps in this chapter to configure your database server before you can 
use Analysis Cubes to create custom reports. 

These configuration instructions apply to: 

 New Vision Analysis Cubes deployments 

 Upgrades from earlier versions of Vision 

 Upgrades from Vision 7.0 and later versions of Analysis Cubes to Vision 7.6 Analysis 
Cubes. 

 Upgrades from Vision 6.x Analysis Cubes to Vision 7.6, regardless of whether or not 
you purchased the Performance Management module 

Upgrade Vision Analysis Cubes from Earlier Versions 

Rebuilding the Analysis Cubes 
If you currently have Analysis Cubes configured and deployed, you must rebuild the Analysis 
Cubes data cubes in their entirety when you upgrade to a new Vision release or applicable 
cumulative update (for cumulative updates please refer to the release notes for information on 
cube related fixes).  

You cannot upgrade the data cubes directly. The Resource Kit will detect and overwrite your 
existing data warehouse (DW), SQL Server agent refresh job and Analysis Services cube 
database. 

The following is a summary of the steps that you must perform to rebuild the Analysis Cubes data 
cubes after you upgrade Vision to a new release, including cumulative updates. 

 

If you are upgrading from Vision 6.x, you must complete the Analysis Cubes configuration steps 
whether or not you purchase the Vision 7.6 Performance Management module. 

 To access the features for Analysis Cubes in Vision 7.6, you must purchase the 
Performance Management module. 

 If you install Vision 7.6 but you do not purchase the Performance Management 
module, you still have access to the same functionality and features that you had in 
your 6.x Analysis Cubes deployment. To be able to access Analysis Cubes, you must 
complete all the Analysis Cubes configuration steps in this chapter. 

To upgrade or rebuild the Analysis Cubes after you install a major release upgrade or 
cumulative update with cube related changes, complete the following steps: 

1. Run the Vision 7.6 database tier installation on your database server to upgrade the 
database tier components. 

2. Delete the existing data warehouse (DW), SQL Server agent job, and Analysis Services 
database. See "Delete Your Existing Data Warehouse and Data Cubes" on page 17. 

3. Complete all the Analysis Cubes configure steps in the Vision Resource Kit and in 
Microsoft SQL Server Management Studio, as outlined in this chapter (as you originally 
did when you first configured the earlier version of Analysis Cubes). 
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Custom Reports Created in Earlier Vision Versions 
The following information applies if you created custom reports with Vision Analysis Cubes 6.x 
and you are upgrading to Vision 7.6. This applies whether or not you purchase and install the 
Vision Performance Management module. 

Renamed and Deleted Vision Fields 
If you have custom reports in which a Vision field name has been renamed, the renamed field is 
automatically removed from your report. You must re-add the new field name to the report.  

Vision fields that were deleted from the Vision database in Vision 7.0 and later, but were included 
in the 6.x database, are automatically removed from your reports.  

 

The "Database Changes" section of the Vision 7.0 and later Release Notes provides a list of 
renamed and deleted fields in the "Removed Columns" and "Removed Tables" subsections. 

Fields that Have Been Moved in the Excel PivotTable Field List 
A small number of dimension and measure fields were moved to different folders in the Excel 
PivotTable Field List in Vision 7.0. If a dimension or measure was moved, it was also removed 
from your existing custom reports. You must re-add it to your reports. 

Summary List of Analysis Cubes Configuration Steps 
The following table lists the steps that are required to configure your database server for Analysis 
Cubes. 

 For upgrade installations, start with Step 1.  

 For new installations, start with Step 2. 

The detailed instructions for each of the general configuration steps are included in the remaining 
sections of this chapter. 

 

SQL Server Clustered Environments 

If you operate in a SQL Server clustered environment, you must follow the instructions in the 
"Appendix A: Configure Vision Analysis Cubes for a SQL Server Clustered Environment" section 
on page 75 of this guide in place of steps 1–6, 9–10, and 16–17 in the following summary list.  

You cannot use the Resource Kit if you have a SQL Server clustered environment. 
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Step Where to Perform Description 

1 Microsoft SQL 
Server Management 
Studio 

This step applies only if you currently use Analysis Cubes 6.x 
and you are upgrading to 7.6. 

Delete your existing data warehouse (DW), SQL Server agent 
job, and Analysis Services database. 

2 Vision Database Tier Install or upgrade to the current version of Vision.  Remember 
to reboot the database server if this is a new installation 
(REQUIRED). 

3 Vision: 
Configuration » 
Module Activation 

If you purchased the Performance Management or 
Performance Management Analysis Cubes module, activate it 
now. 

4 Vision Resource Kit 
on the Vision 
database server 

Check that all prerequisites are installed. 

In the Resource Kit (Analysis Services tab), this is Step 1: 
Check Prerequisites. 

 
The Analysis Cubes Prerequisites section of this guide 
identifies the prerequisites. 

5 Vision Resource Kit 
on the Vision 
database server 

Create the Vision data warehouse and the Vision data cubes 
that are stored in the data warehouse. 

In the Resource Kit (Analysis Services tab), this is Step 2: 
Setup. 

 

6 Microsoft SQL 
Server Configuration 
Manager on the 
Vision database 
server 

Ensure that the SQL Analysis Services Service account has 
rights to the Vision DW database. 

You may need to reconfigure the SQL Analysis Services 
service account to a domain account in order to grant the 
necessary rights. 

See the “Reconfigure the SQL Server Analysis Services 
Service Account” section. 

7 Vision Resource Kit 
on the Vision 
database server 

Apply system labels to the data cubes. 

In the Resource Kit (Analysis Services tab), this is Step 3: 
Apply System Labels to the Cubes. 
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Step Where to Perform Description 

8 Vision Resource Kit 
on the Vision 
database server 

Populate the data warehouse and data cubes with data from 
the transaction database.  

In the Resource Kit (Analysis Services tab), this is Step 4: 
Populate DW and Vision Cubes. 

 
If you did not activate the Performance Management or 
Performance Management Analysis Cubes module in Step 2, 
the cube build process will be complete after you run Step 4 in 
the Resource Kit successfully.  

The remaining steps are only necessary if the 
Performance Management module(s) were activated. 

9 Vision: 
Configuration » 
General » Analysis 
Cubes 

This step applies only if you purchased and activated the 
Vision Performance Management module. 

If you are performing an upgrade installation from Vision 7.0 
or later, you can skip this step since you already completed 
this (unless changes have recently been made to the cube 
configurations and not yet applied). 

In Vision, complete Analysis Cubes Configuration as needed: 
Select the dimensions and measures to populate the data 
cubes; create key performance indicators (KPIs); create 
calculated measures; and set up currency exchange 
information. 

See the Vision online Help for specific instructions. 

10 Vision: 
Configuration » 
General » User-
defined 
Components » 
Fields tab 

This step applies only if you purchased and activated the 
Vision Performance Management module. 

If you are performing an upgrade installation from Vision 7.0 
or later, you can skip this step since you already completed 
this (unless changes have recently been made to the user 
defined components and not yet applied).. 

In Vision, select the user-defined fields to include in the data 
cubes. 

See the Vision online Help for specific instructions. 

11 Vision Resource Kit 
on the Vision 
database server 

Select the Cube configurations saved in Vision check box 
to confirm that you saved the cube configurations (Steps 8 
and 9). 

 
After the cubes are initially deployed this check box will be 
grayed out. 
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Step Where to Perform Description 

12 Vision Resource Kit 
on the Vision 
database server 

This step applies only if you purchased the Vision 
Performance Management module. 

Apply the Analysis Cube settings that you entered in Vision 
Configuration (Steps 6 and 7) to the data cubes. 

In the Resource Kit (Analysis Services tab), this is Step 5: 
Apply Cubes Configurations. 

 

13 Vision Resource Kit 
on the Vision 
database server 

Populate the data warehouse and data cubes. Create the 
SQL Server Agent job to refresh the cubes. You must 
populate the cubes both before and after applying cube 
configurations. 

In the Resource Kit (Analysis Services tab), this is Step 6: 
Populate DW and Vision Cubes. 

 

14 Microsoft SQL 
Server Management 
Studio 

Validate that the Analysis Cubes configuration completed 
successfully. 

15 Microsoft SQL 
Server Management 
Studio 

Create an Analysis Services role for Vision Analysis Cube 
users. After you complete this step, users can access the 
Vision data cubes through your corporate network (LAN or 
WAN). Custom Vision reports can now be created. 

16 Microsoft SQL 
Server Management 
Studio 

Script the Analysis Services role creation for future use. 

17 Vision Web server or 
another server with a 
supported installation 
of IIS (Internet 
Information Services) 

Optional: Configure Analysis Cubes for Internet Accessibility.  

See "Chapter 5: Configure Analysis Cubes for Internet 
Accessibility" on page 38 for instructions. 

18 Vision Resource Kit 
on the Vision 
database server 

and 

Microsoft SQL 
Server Management 
Studio 

If you have multiple Vision databases or you need to support 
cubes in different languages, you must set up data cubes for 
each database. 

Repeat Steps 1–15 of this summary list to create additional 
data cubes. 
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Step Where to Perform Description 

19 Vision Resource Kit 
on the Vision 
database server 

Ongoing Maintenance: After you initially configure Analysis 
Cubes, any time that you modify system labels or Analysis 
Cubes configuration settings in Vision, you must use the 
Resource Kit to apply the changes to the data cubes. 

 

Delete Your Existing Data Warehouse and Data Cubes 
If you are configuring Analysis Cubes for the first time, skip this step, and continue with the next 
section of this chapter. 

The steps in this section apply only if you currently have Analysis Cubes configured and 
you are upgrading from Vision 6.x to Vision 7.6. Complete these steps to delete your existing 
Analysis Cubes components before you deploy Vision 7.6 Analysis Cubes. 

 

The Resource Kit for Vision 7.0 and later has been coded to automatically detect an existing 
Vision 7.x cube deployment and will prompt you to overwrite the components when you re-run 
Step #2 so the manual steps outlined below are not necessary. 

The steps in this section explain how to use SQL Server Management Studio to delete the 
following: 

 Data warehouse database 

 SQL Server Agent job, which refreshes the data 

 Analysis Services database 

Use default naming conventions for the data warehouse, SQL Agent job, and analysis databases. 
Vision 6.x deployments supported custom naming, so the names you used may differ from the 
examples listed below: 

 Data warehouse database name — <Vision database>DW. For example, 
"VisionDemo61DW" in the example below. 

 SQL Server Agent Job — Refresh <Vision database> DW and Cubes. For example, 
"Refresh VisionDemo61 DW and Cubes" in the example below. 

 Analysis Services database — Deltek Vision Analysis 

To delete the Analysis Cubes data warehouse database, the SQL Agent job, and the 
Analysis Services database, complete the following steps: 

1. Connect to the Database Engine using SQL Server Management Studio. 

2. Expand the Databases folder. 

3. Right-click the data warehouse database and click Delete. 

4. Expand the SQL Server Agent folder, and then expand the Jobs folder. 

5. Right-click the SQL Agent refresh job and click Delete. 

6. Connect to Analysis Services using SQL Server Management Studio. 

7. Expand the Databases folder. 
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8. Right-click the Analysis Services database and click Delete. 

Activate the Performance Management Module 
If you purchased the Performance Management module, activate it now if it is not already 
activated. Analysis Cubes became part of the Performance Management module as of Vision 7.0. 

If you have the 6.x version of Analysis Cubes installed: 

 To access the features for Analysis Cubes in Vision 7.6, you must purchase the  
Performance Management module. 

 If you install Vision 7.6 but you do not purchase the 7.6 Performance Management 
module, you still have access to the same functionality and features that you had in your 
6.x Analysis Cubes deployment. 

To activate the Performance Management module, complete the following steps: 
1. From the Vision Navigation menu, click Configuration » Module Activation. 

2. On the Module Activation form, enter your password for the Performance Management 
module, and click OK. 

 

If you purchase and activate the Performance Management module after you complete 
the remaining Analysis Cubes configuration steps, you must repeat all the configuration 
steps to completely rebuild the data cubes. 

Vision Resource Kit 
You use the Vision Resource Kit to: 

 Check that you have all the prerequisites installed. 

 Create the Vision data warehouse and the data cubes. 

 Apply the Vision system labels to the data cubes. 

 Apply the Analysis Cube configurations (KPIs and so on) to the cubes. 

 Populate the data warehouse and cubes with data from your Vision database. 

If you have Vision installed on more than one tier, you must run the Resource Kit from the 
database tier; the Resource Kit is not available on any other Vision tier 

Open the Vision Resource Kit 

To open the Vision Resource Kit, complete the following steps: 
1. From your Vision database server, click Start » All Programs » Deltek Vision » Deltek 

Vision Resource Kit. 
If user account control (UAC) is enabled on your database server, right-click Deltek 
Vision Resource Kit and click Run as administrator on the shortcut menu. 

2. On the Deltek Vision Resource Kit dialog box, click the Database tab. 

3. On the Database Server Logon dialog box, click the OK button.  
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The Windows Integrated check box is selected by default, as only Windows 
Authentication is supported for Analysis Cube deployments. The server name prefills in 
the Server field.  

4. If you are running a non-default SQL Server instance, you must also enter the instance 
name in the Server field (<server>\<instance>). 

Check Prerequisites 
To check that the Analysis Cubes prerequisites are installed correctly, complete the 
following steps: 

1. Once you are authenticated, click the Step 1: Check Prerequisites button to confirm 
whether or not you have all the Analysis Cube prerequisite software installed. 

 If all prerequisites are installed, you receive a Vision BI Prerequisites are satisfied 
message. 

 If prerequisites are not installed, you receive a message that identifies the missing 
prerequisites. You must install or configure all missing prerequisites before you can 
continue with the Analysis Cubes configuration steps. 

Create the Vision Data Warehouse and Data Cubes 
To create the Vision data warehouse and data cubes, complete the following steps: 

1. In the Setup section complete the following actions: 

a. Select your Vision database from the drop-down list in the Vision Databases for BI 
field. 

b. Select a language from the drop-down list in the Language field. 

Possible options, based on the languages that you purchased, are: 

 English (United States) 
 English (International) 
 French (Canada) 
 French (France) 
 Spanish (International) 
 Dutch (Netherlands) 
 German (Germany) 
 Portuguese (Brazil) 
The Data Warehouse Database field prefills with a name that is based on your 
Vision database name and the language that you entered in the Language field. You 
cannot modify the name. The naming convention for the data warehouse database 
name for all languages other than English (United States) is:  

<Your database name>DW_<language culture>.  

In the examples in the table below, “Vision” is the name of the Vision database. DW 
stands for data warehouse. 
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Language That You Entered in 
the Language Field 

Prefilled Data Warehouse 
Database Name 

English (United States) VisionDW 

English (International) VisionDW_en-GB 

French (Canada) VisionDW_fr-CA 

French (France) VisionDW_fr-FR 

Spanish (International) VisionDW_es-ES 

Dutch (Netherlands) VisionDW_nl-NL 

German (Germany) VisionDW_de-DE 

Portuguese (Brazil) VisionDW_pt-BR 

The Analysis Database Name field prefills with a name that is based on your Vision 
database name and the language that you entered in the Language field. You 
cannot modify the name. The naming convention for the analysis database name for 
all languages other than English (United States is: 

Deltek Vision Analysis - <Your Vision Database name>_<Your language culture>. 

In the examples in the table below, “Vision” is the name of the Vision database. 

Language That You Entered in 
the Language Field Prefilled Analysis Database Name 

English (United States) Deltek Vision Analysis - Vision 

English (International) Deltek Vision Analysis - Vision_en-GB 

French (Canada) Deltek Vision Analysis - Vision_fr-CA 

French (France) Deltek Vision Analysis - Vision_fr-FR 

Spanish (International) Deltek Vision Analysis - Vision_es-ES 

Dutch (Netherlands) Deltek Vision Analysis - Vision_nl-NL 

German (Germany) Deltek Vision Analysis - Vision_de-DE 

Portuguese (Brazil) Deltek Vision Analysis - VisionDW_pt-BR 

2. Click the Step 2: Setup button in the Setup section of the Analysis Services tab to create 
the data warehouse and Analysis Services database. 

If you have not entered a module activation code in Vision for Vision Performance 
Management, you receive a message indicating such and an option to proceed.  
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3. If you need to enter your Performance Management module, click No and exit the 
Resource Kit and then enter your module code in Vision Module Configuration; 
otherwise, click Yes to proceed and build the cubes without the VPM module 
enhancements. 

 

You must purchase and activate the Performance Management module to access all 
of the Vision 7.0 and later Analysis Cube configuration features. 

If you purchase and activate the Performance Management module after you deploy 
and configure Analysis Cubes, you must completely rebuild the data cubes. 

4. Click Yes to proceed with the configuration. 

If you previously configured Analysis Cubes for an earlier version of Vision, a message 
informs you that the current cube configuration will be overwritten, including the data 
warehouse, the SQL Agent job, and the Analysis Services database. 

5. Click OK to continue.  

The existing data warehouse and Analysis databases will be deleted and recreated with 
your current configuration settings. This step will not correctly delete your 6.x data cubes. 
You must do that manually as described in the "Delete Your Existing Data Warehouse 
and Data Cubes" section on page 17 before you proceed with this step. 

The data warehouse and Analysis Services database are created now. During this 
process, a dialog box identifies each component as it is created.  

When the process completes, a Setup of Vision Data Warehouse and Cubes has 
been completed successfully message displays at the bottom of the Vision Business 
Intelligence dialog box. 

 

If you see any error messages on the Vision Business Intelligence dialog box, review 
the DeltekVisionResourceKit.log file in the <Vision Installation Directory>\Logs folder 
for details on the errors. 

You will also receive a message reminding you that the Analysis Services service 
account needs to be granted dbo rights to the Vision data warehouse database.  

6. Click OK and refer to the next section to validate or modify the service account 
permissions. 

7. On the Vision Business Intelligence dialog box, click Close. 

Reconfigure the SQL Server Analysis Services Service Account 
When you install Microsoft SQL Server and you use the provided default service accounts, the 
local service accounts for all SQL Server services are configured automatically. The SQL Server 
Analysis Services account will run as “NT Service\MSSQLServerOLAPService.” Because this 
account does not have the necessary rights to the Vision data warehouse database, the SQL 
Agent refresh job that you will perform in Step 5: Populate DW and Vision Cubes in the 
Resource Kit will fail after it runs for a long period of time. 

The SQL Agent job executes Integration Services (.dtsx) packages that bring data into the data 
warehouse database from the Vision transaction database. Then it populates the Analysis 
Services database from the data warehouse. If the Analysis Services service account does not 
have rights to the data warehouse, the second part of the refresh job will fail. 
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If you used the default service accounts when you installed SQL Server, you must reconfigure the 
Analysis Services service account to run as a domain account that has db_owner rights to the 
Vision data warehouse database (for example, <VisionDatabase>DW) before you deploy 
Analysis Cubes. 

 

In addition to the local service accounts created during the SQL Server installation, if you 
assigned a service account for SQL Server Analysis Services that is not a member of the SQL 
Server sysadmin role, the same issue will occur. The service account does not need sysadmin 
rights, only db_owner rights to the Vision data warehouse. 

Reconfigure the Analysis Services Service Account to Run as a Domain 
Account 

To reconfigure the Analysis Services service account to run as a domain account, 
complete the following steps: 

1. On the Vision database server, open the Microsoft SQL Server Configuration manager 
from the Configuration Tools folder of the SQL Server program group. 

2. In the left pane of the Sql Server Configuration Manager screen, click SQL Server 
Services. 

3. In the right pane of the Sql Server Configuration Manager screen, right-click the SQL 
Server Analysis Services service for your instance, and on the shortcut menu click 
Properties. 

On the Log On tab of the SQL Server Analysis Services Properties dialog box, if the 
service is running as a domain account, you can skip steps 4–6, and continue with the 
steps in the next section to grant db_owner rights to the Vision data warehouse 
database. 

4. If the service is not running as a domain account, select the This account: option, and in 
the Account Name field, enter a valid domain username in the form of 
<Domain>\<Username>. 

5. Enter and confirm the password for the domain account. 

6. When you are prompted, restart the service. 

Grant the Domain Account db_owner Rights to the Vision Data Warehouse 
Database  

To grant the domain account db_owner rights to the Vision data warehouse database, 
complete the following steps: 

1. Open and log in to SQL Server Management Studio. 

Log in with an account that has sysadmin rights to the database engine. 

2. In the left pane of the Microsoft SQL Server Management Studio screen, expand the 
Security\Logins folder to see if the Analysis Services service account is listed as a login.   

 If the account is listed as a login, continue with step 3. 

 If the account is not listed as a login: Right-click the logins, and select the option to 
create a new login. Enter the <Domain>\Username> in the Login Name field. Select 
the Windows Authentication option. 
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3. In the Select a page pane of the Login – New screen, click User Mapping. 

4. In the Users mapped to this login: grid, select the check box in the Map column for the 
<Vision>DW database. 

5. In the Database role membership for: <Vision>DW section, select the db_owner 
check box. 

6. Click OK. 

Apply System Labels to the Data Cubes 
This step applies labels that are entered on the Labels tab in Vision Configuration » General » 
System Settings to the data cubes. 

To apply system and custom labels to the data cubes, complete the following steps: 
1. On the Analysis Services tab on the Database tab in the Resource Kit, click the Step 3: 

Apply System Labels to Cubes button to apply your custom field labels to the data 
warehouse. 

2. On the message dialog box that informs you that you are about to make structural 
changes to your Analysis Services database, click Yes. 

3. When you receive a message that the system labels have been successfully applied to 
your Analysis database, click OK.  

 

If there are any errors applying System Labels you will receive a message indicating 
this and that you can obtain the detailed error message by reviewing the 
ApplySystemLabels.log in the Vision Logs directory.  Any errors are more than likely 
due to duplicate system labels in Vision.  You can review the Labels tab of Vision 
System Settings and the Organization names setup for duplicates.  The remaining 
steps in the Resource Kit will be grayed out until the System Labels have been applied 
successfully. 

 

After you initially configure Analysis Cubes, any time you modify a Vision field label, you must 
repeat Step 3: Apply System Labels to Cubes and Step 4: Populate DW and Vision Cubes in 
the Resource Kit. 

Populate the Data Warehouse (DW) and the Vision Cubes 

 

Deltek recommends that you complete this step after business hours when users are not 
connected to the Vision transactional database as information added to the database during the 
cube refresh process can result in data synchronization issues. 

The SQL Agent Refresh Job created includes the Detailed Output Log configured to automatically 
write this log to the Vision Logs folder. The name of the file will be in the following format: 
<Database Name> <Culture>_Refresh.log.   

See “Enable the SQL Agent Job Detailed Output Log” in Chapter 3 if you need to reconfigure this 
for any reason. 
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To populate the data warehouse and the data cubes, complete the following steps: 
1. On the Analysis Services tab (on the Database tab in the Resource Kit), click the Step 4: 

Populate DW and Vision Cubes button. 

2. On the dialog box that recommends that you run this process during off hours, click Yes 
to continue. 

During this process, a status bar displays the progress. 

3. When you receive the message that the Deltek Vision data warehouse and analysis 
cubes have been populated, click OK. 

If you receive a message indicating that the “Population of DW and Vision Cubes 
failed…” see "Chapter 3: Troubleshoot Analysis Cubes Deployments" on page 33 for 
more information. 

Enter Analysis Cubes Configuration Settings in Vision 
These steps apply only if you purchased and activated the Vision Performance Management 
module. 

 

You will not be able to complete the Analysis Cube configuration in Vision until you complete 
Steps 1 through 4 in the Resource Kit.  

Set Up Permissions for the IIS Application Pool Account 
Before you enter and save Analysis Cubes Configuration settings in Vision, the identity of the IIS 
Application Pool that runs the Vision application must have rights to the Analysis Services or 
directly to the Vision data cube itself. If these rights have not been set up, you receive a message 
indicating that the IIS Application Pool Account cannot connect to the Analysis Cubes when you 
save settings in Configuration » General » Analysis Cubes. 

To set up minimal rights, you can set up an Analysis Services role in SQL Server Management 
Studio with the following rights entered on the General page of the Create Role dialog box: 

 Full control (Administrator) 

 Process database 

 Read definition 

Then add the identity of the IIS Application Pool to this Analysis Services role on the Membership 
page of the Create a Role dialog box. 

Only the account running the IIS Application pool needs to be a member of the role with Full 
control (Administrator) rights. You will set up another role (described later in this document) for 
your users, which only needs to have read-level access to the data cubes. 

For detailed instructions on creating a role, see “Create an Analysis Services Role for Your 
Domain Users” on page 29. 

Another way to give the IIS Application Pool rights to the Analysis Services is to add the IIS 
Application Pool identity to the Analysis Server security configuration. To do this, you open SQL 
Server Management Studio, and go to the Properties of the Analysis Server. Add the identity of 
the IIS Application Pool to the Security page. This configuration will allow the IIS Application Pool 
access to all Analysis Cubes on that server. 
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Enter Analysis Cubes Configuration Settings in Vision 
Complete the following Analysis Cubes configuration in Vision: 

Path in Vision Configuration Step 

Configuration » General » 
Analysis Cubes 

Complete Analysis Cubes configuration as needed: 

 Select or hide the dimensions and measures to 
populate the data cubes. 

 Create, delete or modify key performance indicators 
(KPIs). 

 Create calculated measures. 

 Set up currency exchange information. 

See the Vision online Help for more information. 

Configuration » General » 
User-defined Components » 
Fields tab 

Select user-defined fields to populate the data cubes. 

See the Vision online Help for more information and 
instructions. 

After you initially configure Analysis Cubes, any time that you change the Analysis Cubes 
Configuration settings in Vision, you must also complete steps in the Vision Resource Kit as 
described in the next section.  

 

If you hide (clear) a measure or dimension or delete a KPI required by any of the Vision Sample 
Dashboards, you receive a message indicating that you are deleting an object that could be 
used in the sample workbooks provided with the Deltek Vision Performance Management 
module and that by deleting this object you may receive errors when publishing the workbooks.   

If you plan to use the provided sample workbooks select No. If you are not using the sample 
dashboards or the Vision Performance Management module, select Yes. 

Apply Analysis Cubes Configuration that You Entered in Vision 
Once you have successfully completed Steps 1 through 4 in the Resource Kit and saved the cube 
configurations in Vision you will perform the following steps to apply the cube configurations 
saved in Vision to the Analysis Cube. 

 

If you have not purchased the Performance Management Module, the following steps will be 
unavailable in the Resource Kit. 

To apply the configuration for Analysis Cubes from Vision Configuration, complete the 
following steps: 

1. In the Resource Kit, navigate to the Analysis Services tab on the Database tab and select 
the Cube configurations saved in Vision* check box to confirm that you’ve saved the 
cube configurations and to enable step 5. 
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2. Click the Step 5: Apply Cubes Configurations button to apply the settings in Vision 
Analysis Cubes Configuration to the data warehouse and data cubes. 

This step applies the Analysis Cubes settings that you made for the data cubes in Vision 
Configuration » General » Analysis Cubes and in Vision Configuration » General » 
User-defined Components » Fields tab.  

These settings include the dimensions and measures selected to populate the data 
cubes and key performance indicators (KPIs), calculated measures, currency exchange 
information, and user-defined fields for the data cubes. 

3. On the dialog box that informs you that you are about to make structural changes to the 
Analysis Services database, click Yes to continue. 

4. When you receive a message on the Vision Business Intelligence dialog box that all of 
the components were successfully applied, click Close.  

 

After you initially configure Analysis Cubes, whenever you make any changes to the Analysis 
Cubes configuration in Vision Configuration » General » Analysis Cubes or in Vision 
Configuration » General » User-Defined Components » Fields tab, you must repeat the 
Resource Kit Step 5: Apply Cubes Configuration and Step 6: Populate DW and Vision 
Cubes.  

See “Chapter 4: Ongoing Analysis Cubes Configuration Maintenance” on page 37 for specific 
instructions. 

Populate the Data Warehouse and Data Cubes 
After you successfully complete Steps 1 through 5 in the Resource Kit, click Step 6: Populate 
DW and Vision Cubes.  

See the "Populate the Data Warehouse (DW) and the Vision Cubes" section on page 23 for 
instructions. 

After you successfully complete steps 1 through 6, the Analysis Cubes build steps are done.  

The next sections walk you through the process of validating the completion and providing access 
to the cubes to your users. 

Validate that the Analysis Cubes Configuration Completed 
Successfully 
Connect to your Database Engine and Analysis Services using SQL Server Management Studio 
to confirm that: 

 The Vision data warehouse, analysis cubes, and SQL Server agent job to refresh them 
are created. 

 The Vision data warehouse and analysis cubes are populated correctly. 

 The Vision analysis cubes are processed as part of the execution of the SQL Server 
agent job. 
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Connect to Your Database Engine and Analysis Services 

To connect to your Database Engine and Analysis Services, complete the following steps: 
1. Click Windows Start » All Programs » Microsoft SQL Server <version> » SQL Server 

Management Studio. 

2. On the Connect to Server dialog box, complete the following steps: 
a. In the Server Type field, select Database Engine. 

b. In the Server Name field, select your SQL server (and instance, if applicable). 

c. Connect using a Windows account that is a member of the SQL Server sysadmin 
role. 

3. Click the Connect button. 
4. In the Connect drop-down list in the Object Explorer window, select Analysis Service. 
5. Select your Analysis Server as the server name. 

Confirm that the Vision Data Warehouse, Analysis Cubes, and SQL Server 
Agent Job Are Created 
After you connect to your Database Engine and Analysis Services, confirm that the following 
items are added: 

 The Vision data warehouse displays in the Databases folder of the SQL Server Database 
Engine in Microsoft SQL Server Management Studio. The name of the data warehouse is 
your Vision database name with DW appended to it.  For example, if your Vision 
database is named “Vision” you should not also see a database named “VisionDW”. 

 The Refresh <Vision data warehouse name> <language>DW and Cubes job displays 
in the SQL Server Agent Jobs folder. 

 Deltek Vision Analysis - <Vision database name> displays in the Databases folder of 
Analysis Services. 

Validate that the Vision Data Warehouse and Analysis Cubes Are Populated 

To confirm that the Vision data warehouse and analysis cubes are populated, complete the 
following steps: 

1. In the SQL Server Agent Jobs folder, right-click the Refresh <Vision data warehouse 
name> <language> DW and Cubes job, and select View History from the shortcut 
menu. 

2. On the Log File Viewer dialog box, you see a green check mark  beside the date of the 
Refresh <Vision data warehouse name> <language> DW and Cubes job if the Vision 
data warehouse and data cubes were populated correctly. 

If you see a red  instead of a green check mark, refer to the troubleshooting 
information in Chapter 3: Troubleshoot Analysis Cubes Deployments. 

 

The default schedule for the SQL agent job runs every night at 12:00 am. If this schedule 
interferes with your nightly backup or any other processing or SQL agent scheduled jobs, you 
can modify the job to run at an appropriate time for your environment. 
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Validate that the Vision Cubes Are Processed Via the SQL Server Agent 
Job 

To validate that the Vision Project and General Ledger cubes are processed as part of the 
execution of the SQL Server agent job, complete the following steps: 

1. In SQL Server Management Studio, connect to Analysis Services. 

2. In the Object Explorer pane, in Analysis Services, navigate to Databases » Deltek 
Vision Analysis - <Your Vision Database Name> » Cubes.  

3. In the Cubes folder, right-click the Project OLAP Cube folder, and select Properties from 
the shortcut menu. 

In the Status section of the Cube Properties – Project Cube dialog box, the State 
displays Processed. The cubes must be in a processed state for you to be able to 
connect to them. 

4. If the state displays Unprocessed, connect to the SQL Database Engine using SQL 
Management Studio and manually run the SQL Agent job. To do this, right-click the job, 
and click Start Job at Step. 

5. On the Start Job on dialog box, select step ID 1 and click Start. 
6. When the process completes successfully, click Close on the Start Jobs dialog box. 

A successful completion of the SQL Agent refresh job automatically processes both the Project 
and General Ledger data cubes. 

Validate that the Vision Cubes can be Browsed 

To validate that the Vision Project and General Ledger cubes can be browsed, complete 
the following steps: 

1. In SQL Server Management Studio, connect to Analysis Services. 

2. In the Object Explorer pane, in Analysis Services, navigate to Databases » Deltek 
Vision Analysis - <Your Vision Database Name> » Cubes.  

3. In the Cubes folder, right-click the Project OLAP Cube folder, and select Browse from 
the shortcut menu. 

4. Under the Project OLAP Cubes, expand Measures and then Revenue -Project.   

5. Drag the Revenue measure to the grid on the bottom right. If the cube is populated with 
data you will see the balance of the Revenue measure displayed.  

6. To see the Revenue by Project Organization, expand the Projects dimension and drag 
the Projects by Organization hierarchy to the right. You should now see the Revenue 
measure by Project Organization. 

7. The above steps show that the cube has been browsed successfully and that the cube 
has been populated with data. 



Chapter 2: Configure Analysis Cubes 

 

Installation and Configuration Guide for Performance 
Management 29 

 

Create an Analysis Services Role for Your Domain Users 
You must create an Analysis Services role so that the domain users who create Vision custom 
reports have access to the Vision Analysis database—the data cubes. 

To create an Analysis Services role, complete the following steps: 
1. Use SQL Server Management Studio to connect to Analysis Services. 

2. In Object Explorer, navigate to Databases » Deltek Vision Analysis - <Vision 
database name> » Roles. 

3. Right-click Roles, and select New Role from the shortcut menu. 

4. On the General page of the Create Role dialog box, complete the following actions: 

 Enter a name in the Role name field (for example Excel users). 

 Select the Read definition check box for the database permissions for the role. 

5. On the Membership page, add the domain users whom you want as members of the 
Analysis Services role. 

 

Your network administrator may find it easier to create a domain group that contains all 
the necessary domain users. If this is the case, you can add the domain group instead 
of each individual domain user. 

6. On the Data Sources page, select Read in the Access column for the Vision data 
warehouse. 

7. On the Cubes page, select Read in the Access column for both the Project and General 
Ledger OLAP cube.  If you want some users to only have access to the Project OLAP 
Cube then you can create another role where Read Access to the General Ledger OLAP 
cube is set to none.  

8. Change the Local Cube/Drillthrough setting to Drill through for each Vision OLAP 
cube. 

9. On the Create a Role dialog box, click OK to complete the creation of the role. 

10. Have several of your users connect to the Analysis Cube with Microsoft Excel in order to 
validate that they can access the cube and retrieve cube data. 

Script the Role 
After you create an Analysis Services role for Vision Analysis Cube users, Deltek recommends 
that you script the creation of the role so that it can be easily recreated.  

This will be useful to have when you upgrade to a new version of Vision and need to rebuild the 
Vision data warehouse and data cubes. When you rebuild them, any Analysis Service roles that 
you previously created for them are lost. 

To save a role to a script, complete the following steps: 
1. Use SQL Server Management Studio to connect to Analysis Services. 

2. In Object Explorer, navigate to Databases » Deltek Vision Analysis - <Vision 
database name> » Roles. 
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3. Right-click the role that you created for Analysis Cubes, and click Script Role as » 
CREATE To » File on the shortcut menu. 

4. On the Select a file dialog box, save the file as an .XMLA file type to a location on your 
server.  An XMLA file is the Analysis Services equivalent of a database .sql script. 

5. When you rebuild the cubes and need to recreate the role, open the .XMLA file while you 
are connected to Analysis Services and execute it against your Analysis Services 
database. This script recreates the role name and the domain users that are members of 
the role. You then must reassign access to the data source and the data cubes as in 
steps 6 and 7 in the "Create an Analysis Services Role for Your Domain Users" section of 
this document. 

You have completed the Analysis Cubes configuration. 

 

If you want users to be able to access Vision OLAP cubes via the Internet (from outside a 
corporate firewall), you must perform the additional configuration steps that are provided in 
“Chapter 5: Configure Analysis Cubes for Internet Accessibility" on page 38. 

Multiple Vision Databases 
The Vision Resource Kit supports deploying cubes for multiple Vision databases.  

For example, you may have development, test and production copies of the database that you 
need to build cubes on.  

After you follow the Analysis Cubes configuration instructions to create data cubes for one Vision 
database, repeat all the configuration steps to create data cubes for each of your additional 
databases. 

Multiple Languages 

Languages Supported for Analysis Cubes 
Vision supports the creation of data cubes in all the supported languages that can be enabled 
with the Vision Multilingual module. 

Vision Data Cubes for Each Language 
To create custom reports in different languages, you must create separate Vision data cubes for 
each language. To create data cubes for a different language, you repeat the configuration steps 
in this guide choosing the same Vision database but changing the language selection as 
appropriate. In the Vision Resource Kit, you select a different language on the Analysis Services 
tab. The configuration steps are listed in the “Check Prerequisites,” “Create the Vision Data 
Warehouse and Data Cubes,” “Apply System Labels to the Data Cubes,” and “Populate the Data 
Warehouse (DW) and the Vision Cubes” sections of the guide. 

When you create a custom report in Excel, you connect to the data cube with the desired 
language. For example, a Vision English International analysis database that contains the data 
cubes has _en-GB at the end of its name. 
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Creating Custom Reports in Excel Against the Different Language Data 
Cubes 
Users who connect to the language data cubes in Excel must perform an additional step so that 
the Vision dimensions, measures, and system labels display in the correct language in the Excel 
PivotTable Field List.  

For this additional step, users must add a locale identifier code to the connection string in the .odc 
file for each of the Project and General Ledger data cubes. You complete this step one time for 
each data cube. The steps are included here and in the Analysis Cubes section of the Vision Help 
system.   

The locale identifiers for the currently supported languages are listed in the following table: 

Language for the data cubes Locale Identifier # 

English (United States) Not required 

English (International) 2057 

French (Canada) 3084 

French (France) 1036 

Spanish (International) 3082 

Dutch (Netherlands) 1043 

German (Germany) 1031 

Portuguese (Brazil) 1046 

To add a locale identifier code to the connection string in a data cube .odc file, complete 
the following steps: 

1. In Excel, connect to the Vision Project or General Ledger data cube. An .odc connection 
is creating during the connection process. 

2. Use Windows Explorer to navigate to the following location: 

c:\Users\<username>\My Documents\My Data Sources 

3. In the My Data Sources folder, right-click the .odc file for the connect to the language 
data cube.  

The file has the following naming convention: 

 Project data cube: <your Vision server name> Deltek Vision Analysis <your Vision 
database name>_<language> Project OLAP Cube.odc 

 General Ledger data cube: <your Vision server name> Deltek Vision Analysis <your 
Vision database name>_<language> General Ledger OLAP Cube.odc 

You must have Excel open and connected to a Vision language data cube for this file 
to display in Windows Explorer. 

4. On the shortcut menu, click Edit in Notepad. 
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5. In Notepad, find the following odc: ConnectionString line: 

<odc:ConnectionString>Provider=MSOLAP.4;Integrated Security=SSPI;Persist Security 
Info=True;Data Source=<Analysis Server>;Initial Catalog=Deltek Vision Analysis - <your 
database name>_<language> </odc:ConnectionString> 

6. Add ;Locale Identifier=<locale identifier #> to the end of the string as follows: 

<odc:ConnectionString>Provider=MSOLAP.4;Integrated Security=SSPI;Persist Security 
Info=True;Data Source=<Analysis Server>;Initial Catalog=Deltek Vision Analysis - <your 
database name>_<language>;Locale Identifier=<locale identifier 
#></odc:ConnectionString> 

Note the semicolon before Locale Identifier=<locale identifier #>. 

7. Save and close the file in Notepad. 

In Excel, the Vision dimensions, measures, and system labels in the PivotTable Field list for the 
data cube now display in the appropriate language. 

Producing Reports in Both the English United States and English 
International Languages  
If you want to produce the same report in both the English United States and another language, 
you can use one .xlsx Excel report file for both reports. However, if you have Vision system labels 
that are different for each language, any dimensions added to the report design that have a 
system label in their name are removed from the .xlsx file when you are connected to the other 
language and open the report. In that scenario, you need to add the missing dimension back to 
the report, or you could create a separate .xlsx Excel report file for each language. 

An example of different systems labels is having “job” set up as the system label for WBS (work 
breakdown structure) 1 in the English United States Vision data base and “project” set up as the 
system label for WBS 1 in the language Vision data base. 
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Chapter 3: Troubleshoot Analysis Cubes 
Deployments 
You must meet many pre-requisites and complete many individual steps to deploy Vision 
Analysis Cubes successfully. In addition, there may be data-related issues during the process 
because data is copied and transformed from your Vision transaction database to the data 
warehouse and then to the Analysis Services database. Failures can occur during any of these 
steps. 

The following table provides some basic troubleshooting information. 

Step Where You Encounter 
Problems 

What to Do 

Step 1: Check Pre-requisites in the 
Resource Kit 

Review the pre-requisite requirements at the 
beginning of this guide. 

Step 2: Setup in the Resource Kit Ensure that you have upgraded the Vision database 
tier installation to the current version. 

Review the DeltekVisionResourceKit.log file in the 
\Vision\Logs folder. To access this log in Resource Kit 
directly, click File » View Log. If you need to open a 
Customer Care incident, be sure to include this log file 
which is located in the Vision\Logs folder. 

Step 3: Apply System Labels to Cubes 

 

Review the ApplySystemLabels.log in the Vision Logs 
folder for errors. If you need to open a Customer Care 
incident, be sure to include this log file which is 
located in the Vision\Logs folder. 

Steps 4 & 6: Populate DW and Vision 
Cubes in the Resource Kit 

Review the SQL Server Agent job detailed output log 
for errors.  That log is located in the Vision\Logs 
directory and is in the format <Database Name> 
<Culture>_Refresh.log. 
If you need to open a Customer Care incident, be sure 
to include this log file which is located in the 
Vision\Logs folder. 

If you did not reboot the database server since initially 
installing Deltek Vision then the data cube 
environment variables are not initialized and the SQL 
Agent Refresh job will fail. 

If the SQL Server Analysis Services service account 
does not have the necessary rights to the Vision data 
warehouse database or if the SQL Agent Service 
account does not have rights to Analysis Services, the 
SQL Agent refresh job in step 5 will fail. For more 
information, see the Section on “Service Accounts and 
Permissions” on page 9. 
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Step Where You Encounter 
Problems 

What to Do 

Step 5: Apply Cubes Configurations in 
the Resource Kit 

Review the DeltekVisionResourceKit.log file in the 
\Vision\Logs folder. To access this log in Resource Kit 
directly, click File » View Log. If you need to open a 
Customer Care incident, be sure to include this log file 
which is located in the Vision\Logs folder. 

 

Enable the SQL Agent Job Detailed Output Log 
Use the detailed output log to troubleshoot failures in the Analysis Cube SQL Agent refresh job. 
This log is automatically created in the Vision logs directory with the name in the form of <Vision 
Database> <language>_Refresh.log. 

When you installed Microsoft SQL Server, if you used the default service accounts that were 
provided, the SQL Server Agent Refresh Job account runs as “NT Service\SQLServerAgent.” 
This account does not have the necessary rights to the file system on the server for the Vision 
Analysis Cubes detailed output log to be created.  

To enable the necessary rights to create the detailed output log, you must reconfigure the SQL 
Agent service to run as a domain account that has modify rights to the Vision Logs folder. Then 
follow the steps below to enable the detailed output log. If you enable the detailed output log, but 
the SQL Server Agent Refresh Job account does not have the necessary rights, you will see an 
error in the job history log about the service account being denied access to the Vision logs 
folder. (To open the history log, right-click the SQL Agent job, and click View History from the 
shortcut menu.) 

To validate the detailed Analysis Cubes output log, complete the following steps: 
1. Open SQL Server Management Studio, and connect to the database engine. 

2. Expand the SQL Server Agent folder, and then expand the Jobs folder. 

3. Locate the SQL Agent job that is named “Refresh <Vision Database> <language> DW 
and Cubes” (for example: Refresh VisionDemo73-en-US DW and Cubes). 

4. Right-click the job, and click Properties on the shortcut menu. 

5. Click the Steps page, select step ID 1, and then click the Edit button. 

6. Select the Advanced page, and in the Output file field, enter or browse to the path for 
the Vision logs directory (e.g. c:\program files\Deltek\Vision\Logs). Then add a log file 
name to the path in the Output field (for example: SQLAgentRefresh.log) and click OK. 

7. On the Advanced page, click OK to return to the Steps page. 

8. On the Steps page, click OK. 

9. Manually run the SQL Server Agent job. To do this, right-click the job in the Jobs folder, 
and choose Start Job at Step… from the shortcut menu. 

10. On the Start Job on dialog box, select step ID 1, and click Start. 
11. After the job finishes successfully, click Close. 

12. When the SQL Server Agent job is complete, retrieve the output log that you created in 
step 6. Include it in your Customer Care case submission. 
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Problems and Solutions 
Solutions to a variety of known problems are listed below: 

Problem: 
An error is received running Step 4 in the Deltek Vision Resource Kit to build the Analysis 
Cubes.  Reviewing the Resource Kit log file, the following error is identified: 
<Date> <Time> - <User> - DeltekVisionHelper (ProcessCubeChanges_UDF) - Adding Projects measures... 
<Date> <Time> - <User> - DeltekVisionHelper (ProcessCubeChanges_UDF) - Error: The measure name needs to be 
unique in the cube. 

Solution: 
In this case there was a Project UDF (User Defined Field) with the same label as a Project 
Measure.   

Because there are a significant number of project measures and UDF’s, you can utilize the 
Conditional Formatting feature of Excel to quickly identify the duplicate UDF labels that need to 
be changed. 

To identify the duplicates, complete the following steps 
1. From the Vision Navigation menu, click Configuration » General » Analysis Cubes. 

2. Click the Measures tab of the Analysis Cubes form. 

3. From the Standard Measures drop-down list in the menu bar above the measures, 
select Export to Excel. 

4. Click Configuration » General » User Defined Components. 

5. From the Application drop-down list, select Projects. 

6. Click the Custom Fields tab. 

7. From the Custom Fields drop-down list In the menu bar above the custom fields, click 
select Export to Excel. 
You now have two excel files, which you can compare to identify duplicate labels. 

8. Copy the rows from the Label column in the UDF export and paste these rows at the end 
of the Default Field Name column in the Measures export.  

Depending on the number of measures, this will be somewhere around row 830.   

Do not sort the column! 

9. Highlight the Default Field Name column (which now has the UDF labels as well) and in 
Excel select Conditional Formatting » Highlight Cell Rules » Duplicate Values… , 
and then click OK in the Duplicate Values dialog box. 

10. Scroll down to row 830 (where you pasted in the UDF labels) and look for highlighted 
records. These highlighted records reflect duplicate UDF labels that match existing 
measure names. You must change them in the UDF application to avoid conflicts. 

11. After you change the duplicate UDF labels, save your changes and re-run Step 4 in the 
Resource Kit. Adjust the UDF and Measure type accordingly for example, Employees, 
Opportunities, and so on) in the steps above. 
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Problem: 
If you are using SQL 2014 and running a maintenance plan to rebuild indexes on the Vision 
database you may find that the cube refresh process takes up to twice as long to complete after 
the maintenance plan is run.  Additionally, a reboot of the server or a restart of the SQL Server 
service brings the total processing time back to what it was previously. 

Solution: 
In this specific situation it was determined that the new SQL 2014 Cardinality Estimator was 
somehow getting a bad query execution plan on a table variable used in one of the DW functions.  
Modifying the cube refresh job to turn on a SQL Server trace flag prior to the job and turn it off 
after the job resolved the problem.  Details of the job modification are shown in the screenshot 
below.  Specifically, we are adding a steps with a DBCC TRACEON (2453, -1) command before 
the refresh step annd adding a step with a DBCC TRACEOFF (2453, -1) after the refresh step. 

 
More information on SQL Server Trace Flag 2453 can be found in the following Microsoft KB: 

https://support.microsoft.com/en-us/kb/2952444 

https://support.microsoft.com/en-us/kb/2952444
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Chapter 4: Ongoing Analysis Cubes Configuration 
Maintenance 
After you initially configure Analysis Cubes, whenever you make changes to Vision system labels 
or to Analysis Cubes configuration settings in Vision, you must repeat some Analysis Cubes 
configuration steps. 

In addition, you must completely rebuild the cubes with each new Vision release. You must also 
rebuild the cubes with certain Cumulative Updates – see the Cumulative Update Release Notes 
for information on whether a cube-related change or fix means that you must rebuild the cubes. 

System Label Changes in Vision 
Whenever you make a system label change in Vision (Configuration » General » System 
Settings » Labels tab), you must rebuild the data cubes. To rebuild them, re-run all steps in the 
Resource Kit as you did when you initially built the cube. Step 2 of the Resource Kit will identify 
an existing instance of the DW and Cubes and will delete them first prior to building the new DW 
and Cubes. 

 

If you only rerun Step 3: Apply System Labels to the Cubes in the Vision Resource Kit after 
you change a system label in Vision, the labels are not correctly reapplied in the data cubes. 

Analysis Cubes Configuration Changes in Vision 
Anytime that you make changes to the following Analysis Cubes configuration in Vision, complete 
the Resource Kit steps below to update the Analysis Cubes: 

 Vision Configuration » General » Analysis Cubes — Dimensions and measures 
selected to populate the data cubes, KPIs, calculated measures, and currency exchange 
information) 

 Vision Configuration » General » User-Defined Components » Fields tab — 
User-defined fields to populate the data cubes.  These changes include checking the box 
“Available for Analysis Cubes” or unchecking that box on a previously added User 
Defined Field or deleting a user defined field that was made available to Analysis Cubes. 

You can access Analysis Cubes configuration only if you purchased and activated the Vision 
Performance Management module. 

To update the data cubes with the current Analysis Cubes configuration entered in Vision, 
complete the following steps: 

1. From your Vision database server, click Start » All Programs » Deltek Vision » Deltek 
Vision Resource Kit. 

2. On the Deltek Vision Resource Kit dialog box, click the Database tab. 

3. In the Setup section on the Analysis Services tab of the Database tab, click Step 5: 
Apply Cubes Configurations. See page 25 for specific instructions. 

4. Run Step 6: Populate DW and Vision Cubes in the Resource Kit. See instructions on 
page 26, or run the SQL Agent refresh job in SQL Server Management Studio to refresh 
your data warehouse and cubes. 
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Chapter 5: Configure Analysis Cubes for Internet 
Accessibility 
If you want users to be able to access Vision OLAP cubes via the Internet (from outside a 
corporate firewall), complete the configuration steps in this section. Using these instructions, you 
will configure Internet Information Services (IIS) to allow Microsoft Excel to access Analysis 
Services via HTTP.  

You must complete the instructions in the previous sections of this guide to configure Analysis 
Cubes before you complete the instructions in this section to configure Analysis Cubes for 
Internet accessibility. 

Install and Configure the OLAP Data Pump 
You can perform the following steps on any server running IIS that has been configured to be 
allowed access from the Internet and configured to have access to the Analysis Services 
database. In many cases, this may be the Vision Web/application server. 

 

Windows Integrated Authentication will not work with Excel if users are not authenticated to the 
domain. Therefore, for this to work for Internet users, the OLAP virtual directory must be 
configured for Basic Authentication. With Basic Authentication, users still enter their domain 
credentials, but they are passed in clear text. For this reason, you must secure the Web site that 
is hosting the OLAP virtual directory with an SSL certificate. 

The OLAP Data Pump component is loaded into IIS and serves as an ISAPI extension to pump 
data from the client to an Analysis Services server and back.  

You must configure the OLAP Data Pump if you are configuring the Analysis Cubes to be 
accessed by Excel for Internet users. 

The following steps guide you through installing and configuring the Microsoft OLAP Data Pump. 

Step 1: Get Binaries 
Copy the contents of the %SSAS Installation folder%\OLAP\bin\isapi folder on the Analysis 
Services server into the folder that you want to serve as the base for the virtual directory in IIS on 
the web server which will host the OLAP data pump.  This web server may or may not be your 
Vision web server. 

In this example, we copy all the files from the C:\Program Files\Microsoft SQL 
Server\MSAS10.MSSQLSERVER\OLAP\bin\isapi folder into the C:\inetpub\wwwroot\olap folder. 
Note that your SQL path will be different dependent on the version of SQL Server and instance 
name. 

The following guidelines apply: 

 To take advantage of the full set of security settings, it is important to make sure that the 
folder that serves as the base for the virtual directory is located on the drive that is 
formatted for the NTFS file system. 

 Because of IIS limitations, the path to your directory must not contain spaces. 

 If you plan to run the HTTP pump on a different server than the Analysis Services server, 
you must also install OLEDB for Analysis Redistributable package for your version and 
platform of SQL Analysis Services on the Web server hosting the OLAP Data Pump. See 
“Configure Settings if Data Pump and SSAS Are on Different Servers” on page 41. 
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Step 2: Create an Application Pool 

To create an application pool, complete the following steps: 
1. Click Windows Start » Control Panel » Administrative Tools » Internet Information 

Services to open the IIS Manager. 

2. In the IIS console, expand the Server Name node. 

3. Right-click Application Pools, and click Add Application Pool on the shortcut menu. 

4. On the Add Application Pool dialog box, complete the following: 

 In the Name field, enter a name for the application pool. In this example, it is olap. 

 In the .Net Framework version field, select .NET Framework v2.0.5027. 

 In the Managed pipeline mode field, select Classic. 

Step 3: Create a Virtual Directory 

To create a virtual directory, complete the following steps: 
1. In the Connections pane of the IIS console, expand Sites, and then expand Default Web 

Site (or the site name that you use). 

2. Right-click the Web site, and click Add Application on the shortcut menu. 

3. On the Add Applications dialog box, complete the following: 

 In the Alias field, enter the name for the virtual directory. In this example, it is olap. 

 The content directory in the Physical path field must point to the folder that you 
created. 

4. Click OK to create the application. 

5. In the Connections pane, click the OLAP virtual directory, and double-click Handler 
Mappings in the /OLAP Home pane. 

6. In the Actions pane on the right, click Edit Feature Permissions. 
7. On the Edit Feature Permissions dialog box, select the Read and Script permissions 

check boxes if they are not selected, and click OK. 

8. In the Actions pane, click Add Script Map…. 

9. On the Edit Script Map dialog box, complete the following, and then click OK. 

 In the Request path field, enter *.dll. 
 In the Executable field, browse to and select the location of the msmdpump.dll file. 

For multiple instances, be sure to point to the appropriate physical instance folder. 

 In the Name field, enter OLAP. 

10. On the Add Script Map dialog box, click Yes to add the ISAPI extension and save. 

11. To see the ISAPI extension that was added, click the Server Name node in the IIS 
console, and double-click ISAPI & CGI Restrictions. 

12. In the ISAPI and CGI Restrictions pane, double-click OLAP Data Pump. 
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Step 4: Configure Security for Excel Access over the Internet 

Before you begin the following procedure to configure security for Excel access over the internet, 
enable Basic Authentication in your IIS configuration if it is not currently enabled. To do so, go to 
Server Manager » Roles » Web Server (IIS) » Add Role Services. 

To configure security for Excel access over the Internet, complete the following steps: 
1. In the Connections pane of IIS Manager, select the OLAP virtual directory. 

2. In the /OLAP Home pane, double-click Authentication. 

3. In the Authentication pane, select Basic Authentication. 

4. In the Actions pane, click Enable and then click Edit. 
5. On the Edit Basic Authentication Settings dialog box, configure the default domain: 

6. If it is appropriate, disable Anonymous Authentication and Windows Authentication. 

Step 5: Select the Target Analysis Services Server 
As the architectural diagram on page 38 shows, every instance of the OLAP Data Pump uses its 
own configuration file. 

Open the msmdpump.ini file in your folder. The contents of the file should look like the following: 

<ConfigurationSettings> 

<ServerName>localhost</ServerName> 

<SessionTimeout>3600</SessionTimeout> 

<ConnectionPoolSize>100</ConnectionPoolSize> 

<MinThreadPoolSize>0</MinThreadPoolSize> 

<MaxThreadPoolSize>0</MaxThreadPoolSize> 

<MaxThreadsPerClient>4</MaxThreadsPerClient> 

</ConfigurationSettings> 

The only setting of interest, at this point, is <ServerName>. If the Analysis Services instance to 
which you must provide access is located on the local machine and installed as a default 
instance, you have no reason to change this setting. If it is not located and installed in this way, 
you must specify the machine name and instance name (mymachine\inst1).  

The key setting at this point is <ServerName>. If the Analysis Services instance to which you 
must provide access is located on the local machine and installed as a default instance, do not 
change this setting. Otherwise, you must specify the machine name and instance name: 

<ServerName>mymachine\inst1</ServerName> 

Step 6: Get it All Together 
At this point, your HTTP pump is configured, and you can connect from your application. 

If your application provides a way to specify the server name, replace your server name with the 
path to your virtual directory concatenated with msmdpump.dll. For example:  

http://MyMachine/olap/msmdpump.dll 
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After you install the Microsoft OLAP Data Pump, complete the following tasks: 

 Configure settings, if the data pump and OLAP are not on the same server. 

 Test the data pump configuration. 

Configure Settings if Data Pump and SSAS Are on Different Servers 
If the data pump and SSAS are not on the same server, install the following prerequisite software 
components: 

 Download the appropriate feature pack files for your version and platform of SQL Server 
Analysis Services. 

SQL 2012 SP3 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=49999 
x64 - ENU\x64\SQL_AS_OLEDB.msi 
 
SQL 2014 SP1 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=46696 
x64 - ENU\x64\SQL_AS_OLEDB.msi 
 
SQL 2016 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=52676 
x64 - ENU\x64\SQL_AS_OLEDB.msi 

 Modify the ServerName setting in the msmdpump.ini file to point to the location of the 
SSAS server. Change localhost to the name of your SSAS server, including the instance 
name if applicable: 

<ConfigurationSettings> 
<ServerName>localhost</ServerName> 
<SessionTimeout>3600</SessionTimeout> 
<ConnectionPoolSize>100</ConnectionPoolSize> 
</ConfigurationSettings> 

Test the Data Pump Configuration 
Complete the following actions to test the data pump configuration: 

 Test the URL. 

 Test the connection using SQL Management Studio. 

 Test the connection using Excel. 

Test the URL 

To test the URL to ensure that the data pump is set up correctly, complete the following 
steps: 

1. Access the data pump URL (http://<IISServer>/<OLAPVirtual>/msmdpump.dll) .  

2. Go to Internet Explorer Advanced Settings.  

3. Clear the Show friendly HTTP error messages check box. The following information 
displays:  

 <soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"> 
 <soap:Body> 
 <soap:Fault xmlns="http://schemas.xmlsoap.org/soap/envelope/"> 

https://www.microsoft.com/en-us/download/details.aspx?id=52676
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 <faultcode>XMLAnalysisError.0xc10e0002</faultcode>  
 <faultstring>Parser: The syntax for 'GET' is incorrect.</faultstring>  
 <detail> 
 <Error ErrorCode="3238920194" Description="Parser: The syntax for 'GET' is incorrect." 
Source="Unknown" HelpFile="" />  
 </detail> 
 </soap:Fault> 
 </soap:Body> 
 </soap:Envelope> 

Though the information above reflects an error, this message indicates that the data pump is 
configured correctly. 

If the information above does not display in the browser, check the Application Event log on the 
server for errors. 

Test the Connection Using SQL Server Management Studio 
You can use HTTP and SQL Server Management Studio to test the data pump connection to the 
Vision Analysis Cubes.  

However, you cannot test the connection using SSMS if you chose Windows Integrated 
Authentication for the IIS virtual directory. In that case, you can temporarily set the IIS virtual 
directory permissions for Anonymous Access and test the configuration. Remember to change 
the Anonymous Access account to a user account that has read access to the Vision Analysis 
Cubes. After you complete the test, enable Windows Integrated Authentication again. 

Test the Connection Using Excel 
You can use HTTP and Microsoft Excel to test the data pump connection to Vision Analysis 
Cubes. However, you cannot test the connection using Excel if you chose Windows Integrated 
Authentication for the IIS virtual directory. In that case, you can temporarily set the IIS virtual 
directory permissions for Anonymous Access and test the configuration. (Remember to change 
the Anonymous Access account to a user account that has read access to the Vision Analysis 
Cubes. After you complete the test, enable Windows Integrated Authentication again. 

Configure the Data Source in Excel 
After you configure IIS per the “Install and Configure the OLAP Data Pump” section, Internet 
users can use the URL when they configure the data source in Excel. 

To configure the data source in Excel, complete the following steps: 
1. In Excel, click the Data tab, and then click From Other Sources » From Analysis 

Services. 

On the Connect to Database Server page, enter the following information and click Next: 
 In the Server name field, enter the URL (http://<IISServer>/olap/msmdpump.dll). 
 Select the Use the following User Name and Password option. 

 In the User Name field, enter the user name (in form of domain\user). 
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2. On the Select Database and Table page, select the database from the drop-down list, 
select the cube that you want to connect to, and then click Next. 

3. On the Save Data Connection File and Finish page, select the Save password in file 
check box and click Finish. 

When you select the Save password in file check box, your domain password is saved 
in clear text in the data source connection file, which is a potential security risk. However, 
not selecting the check box will prompt you to re-enter the password. 

 

4. On the Import Data dialog box, click OK. 

If you did not select the Save password in file check box in Step 4, you may receive an 
“Installation of the data source failed” error. 

5. Click OK. 

6. On the Multidimensional Connection page, re-enter your password and click Next. 
7. On the Select the database that you want to work with page, click Finish to begin using 

the cube data in Excel. 
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Chapter 6: Performance Management Dashboards 
Installation and Configuration 
With Tableau Server and Tableau Desktop (products of Tableau Software, Inc.), you can use 
Vision Project Cubes and General Ledger Cubes data sets and analysis services to create role-
based graphical performance dashboards. These performance dashboards can then be added as 
Web dashparts on the Vision Dashboard. You must complete the installation and configuration 
steps in this chapter to use Tableau Server/Tableau Desktop with Vision. 

Note on Terminology 
Tableau uses the following key terms in its software and supporting documentation: 

 Workbook — A workbook is basically a Web page that functions as a container for 
displaying a set of Views. 

 View — A view is a chart or table that provides a graphical representation of the values 
of the critical metrics that you select for that chart or table. 

Because these terms are generally not familiar to users of business intelligence software 
applications, in the Vision online help, “Dashboard” and “chart” are used instead of “workbook” 
and “view.” However, because this guide focuses on installing, configuring, and using the Tableau 
Server/Tableau Desktop software itself, this guide uses the original Tableau terms. 

 As you use Tableau, you may encounter the additional terms listed below. Though many 
of these are not used in Vision Performance Management, being familiar with them will help you 
understand and work with Tableau and the Tableau documentation: 

 Site — A logical security separation of workbooks, views, and users. Sites are used with 
Vision Performance Management to provide access to different Analysis Cubes for 
customers who have multiple Vision databases (for example, a production database and 
a test database,) or for customers who have the Vision Multilingual module and want 
Analysis Cubes and performance dashboards in multiple languages. See “About Tableau 
Sites” on page 64 for more information. 

 Project — A collection of related workbooks. Vision Performance Management does not 
use projects. 

 Groups — A method for grouping users to make it easier to assign permissions. Vision 
Performance Management does not use groups. 

 Data Sources — A reliable connection to data. Vision Performance Management does 
not use data sources. 

 Data Connections — Every workbook that is published to the server contains a data 
connection. The data connection information is embedded into each workbook during the 
publishing process. 

 Schedules — Used with server side tasks. Vision Performance Management does not 
use schedules. 

 Tasks — Jobs performed by Tableau Server. Vision Performance Management does not 
use tasks. 

 Subscriptions — A subscription is a view or workbook on Tableau Server that users can 
receive a snapshot of via email. Subscriptions are not used with Vision Performance 
Management. 
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Logical Tier Model 

 

Deploy Deltek Vision with Analysis Cubes 

Before You Begin 
Before you install the Tableau Server software, you must configure the Vision Analysis Cubes. 
Data for the provided sample workbooks is based on the Analysis Cubes, not the Vision database 
although you can build custom workbooks that report directly on your Vision transaction 
database. See “Chapter 2: Configure Analysis Cubes” on page 10 for more information. 

 

With Vision 7.6 and later, Deltek is only supporting the Tableau Server 64-bit installation.  

If you have previously installed Tableau 8.0.2 (Vision 7.1/7.2) on a 32-bit server, a new 64-bit 
server will be required to install future versions of Tableau. 

The following additional prerequisites must also be met: 

 Install or upgrade Vision, including the database tier, to Vision 7.6. The installation 
process installs or upgrades the Analysis Services files and sample workbooks.  
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 Deploy or rebuild the Vision Analysis Cubes. If you have existing Vision 7.x Analysis 
Cubes deployed, the Resource Kit prompts you to overwrite them.  

 Workbook publishing functionality is now performed in Vision via the Performance 
Management application, so you must install the Tableau Command Line utility on 
the web/application server.  

 See the Vision Help for instructions on publishing the workbooks. Publishing 
workbooks via the Resource Kit on the database server is no longer available. 

 The supported versions of Vision and Tableau Server/Desktop are listed below. Only 
the supported Tableau version listed is supported for the version of Vision listed: 

 Vision 7.1/7.2–Tableau 8.0.2 

 Vision 7.3–Tableau 8.1.6 

 Vision 7.4–Tableau 8.2 / Tableau 9.0.4  

 Vision 7.5–Tableau 9.0.4 / Tableau 9.3.5 (Vision 7.5 CU# 12) 

 Vision 7.6–Tableau 9.2.0 / 9.3.5 (Vision 7.6 CU# 02) 
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All Tableau versions prior to 9.3.5  have security vulnerabilities that can be resolved by 
upgrading to 9.3.5., Deltek is supporting Tableau version 9.3.5 with Vision 7.6 and 7.5) , which 
includes the correction to these security vulnerabilities.   

All customers currently using Tableau 9.0.4, 8.2, 8.1.6, or 8.0.2 are encouraged to upgrade 
Tableau to version 9.3.5 when available..  More information on these security vulnerabilities can 
be found in the Tableau Knowledge Base articles referenced below:: 

 ADV-2015-001 Security Advisory: Information Disclosure  

 Affected product(s): Tableau Server 

 Rating: High 

 Knowledge Base article: http://kb.tableau.com/articles/knowledgebase/2016-005-
security-advisory-information-disclosure-in-tableau-server  

 ADV-2015-001 Security Advisory: Buffer Overflow Vulnerability  

 Affected product(s): Tableau Server 

 Rating: High/Critical 

 Knowledge Base article: http://kb.tableau.com/articles/knowledgebase/2015-001-
security-advisory-buffer-overflow-vulnerability 

 ADV-2015-002 Security Advisory: Server Configuration Information Disclosure  

 Affected product(s): Tableau Server 

 Rating: High 

 Knowledge Base article: http://kb.tableau.com/articles/knowledgebase/2015-002-
security-advisory-server-configuration-information-disclosure 

 ADV-2015-003 Security Advisory: Saved Workbooks May Contain Data Source 
Credentials  

 Affected product(s): Tableau Server, Tableau Desktop, Tableau Online 

 Rating: Moderate 

 Knowledge Base article: http://kb.tableau.com/articles/knowledgebase/2015-003-
security-advisory-saved-workbooks-may-contain-data-source-credentials 

 ADV-2015-004 Security Advisory: Tableau Desktop for Mac Might Treat Untrusted 
Certificates as Valid  

 Affected product(s): Tableau Desktop 

 Rating: Medium-Low 

 Knowledge Base article: http://kb.tableau.com/articles/knowledgebase/2015-004-
security-advisory-tableau-desktop-for-mac-might-treat-untrusted-certificates-as-
valid 

 If you are upgrading from a previous version of Vision Performance Management, you 
must uninstall the previous version of the Tableau Server, Desktop and Command Line 
utility and install the newly supported version. 

 Review and identify your Vision Performance Management tier configuration. Deltek 
recommends that you install Tableau Server on a dedicated server.  

Review the requirements for the server hosting Tableau Server 
(http://www.tableau.com/products/techspecs) and contact Deltek Sales Engineering for 
assistance in determining the optimal configuration for your firm. 

For related information, see the following: 

http://kb.tableau.com/articles/knowledgebase/2016-005-security-advisory-information-disclosure-in-tableau-server
http://kb.tableau.com/articles/knowledgebase/2016-005-security-advisory-information-disclosure-in-tableau-server
http://kb.tableau.com/articles/knowledgebase/2015-001-security-advisory-buffer-overflow-vulnerability?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-001-security-advisory-buffer-overflow-vulnerability?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-002-security-advisory-server-configuration-information-disclosure?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-002-security-advisory-server-configuration-information-disclosure?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-003-security-advisory-saved-workbooks-may-contain-data-source-credentials?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-003-security-advisory-saved-workbooks-may-contain-data-source-credentials?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-004-security-advisory-tableau-desktop-for-mac-might-treat-untrusted-certificates-as-valid?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-004-security-advisory-tableau-desktop-for-mac-might-treat-untrusted-certificates-as-valid?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
http://kb.tableau.com/articles/knowledgebase/2015-004-security-advisory-tableau-desktop-for-mac-might-treat-untrusted-certificates-as-valid?utm_campaign=Tableau%20Security%20Update%20-%20USCA%20en-US%20-%202015-12-22&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000006181652&elq=0961fd52f71b43a890d107d5914facac
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 “Distributed Environments” in the Tableau Server 9.3 Server Admin Guide 

 “Virtual Environments” on the “Technical Specifications – Tableau Server” page 
(http://www.tableau.com/products/techspecs) 

 The Deltek VPM installer will check for the required Tableau minimum system 
requirements which are no longer a warning as in previous versions. If your system 
does not meet the minimum requirements you will not be able to proceed with the 
installation. 

 Similarly, the Tableau installation (if run separately) will provide the following failure if 
the system does not meet the minimum specifications and you will not be able to 
proceed with the installation: 

 

   -- Verification result: FAILEDSetup cannot continue because the system does 
not meet minimum requirements. Please make sure that the system meets the 
minimum recommended Tableau Server requirements: 
http://www.tableausoftware.com/products/server/specs 

 

Reason: 

Processor (cores): 1 (minimum required is 4) 

Memory: 2 GB (minimum required is 8 GB) 

 

Other resources found: 

Available disk space: 27.66 GB 

Operating System: Microsoft Windows Server 2012 Standard 

 Download the Vision 7.6 Vision Performance Management Installer from DSM. 

 Review the following Deltek-specific configuration notes: 

 Licensing  

 You must have a license for the Vision Performance Management module to 
deploy Tableau Server workbooks.  

 Tableau Server and Desktop license keys are provided by Deltek as part of 
Vision Performance Management. If you have not received them, contact your 
Account Manager. 

 Authentication — Decide on an authentication method before proceeding. If you 
need to change the authentication method later, you must uninstall and reinstall 
Tableau Server. See “Tableau Security Configuration” on page 52 for additional 
information. 

 Support — Use Deltek Customer Care for all product support needs. You will not be 
able to contact Tableau Software Support directly. 

Identify Your Deployment Strategy 
Before you install the server software, consider the following questions: 

 Where will you install the Tableau Server software? 

 What type of security will you use? 

http://www.tableausoftware.com/products/server/specs
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 Do you need to install the Microsoft OLAP Data Pump? 

 Will the performance dashboards or Tableau Server be accessed by Internet clients? 

 Does your Vision deployment support multiple databases or multiple languages? 

Where will you install the Tableau Server software? 
Before you install the Tableau Server software on a server, review Tableau Server technical 
specifications athttp://www.tableau.com/products/techspecs.  

Deltek does not recommend installing the Tableau Server software on any Deltek Vision tier. 

 

Tableau Server 9.0 has imposed hard limits for the system requirements such that if your server 
does not meet the minimum system requirements you will not be able to proceed with the 
installation.  These requirements are a server with 4 cores and 8 GB of RAM. 

What type of security will you use? 
For ease and consistency of implementation, Deltek suggests that you choose security for 
Tableau Server based on the security you implemented for Vision. Vision supports two methods 
of authentication: 

 Vision Security — If you use Vision security (application-level users and passwords), we 
suggest that you use Local authentication when you configure Tableau Server. 

 Windows Integrated Authentication — If you use Windows Integrated security for 
Vision, your users authenticate to Vision using their Active Directory login. In this case, 
we suggest that you use Active Directory authentication when you configure Tableau 
Server. 

 If you use Windows Integrated Authentication with Vision but also have Vision security 
users, those users will not be able to access the performance dashboards until their 
domain accounts are added as Tableau users. 

These are only suggestions, however. You can use either Tableau Server security option, 
regardless of your Vision security, and you do not need to change your Vision security model to 
implement the Tableau Server software. 

 

See “Tableau Security Configuration” on page 52 for more details on security.  

Do you need to install the Microsoft OLAP Data Pump? 
The Microsoft OLAP data pump is a Web server extension installed in IIS. The OLAP data pump 
is only required under the following circumstances: 

 Internet users outside of your network (not VPN users) need to connect Tableau Desktop 
to the Vision Analysis Cubes to create custom workbooks. 

 Users outside of your network need to connect to the Analysis Cubes with Excel. 

For installation and configuration instructions, see “Chapter 5: Configure Analysis Cubes for 
Internet Accessibility” on page 38. 
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Will Tableau Server software or Vision performance dashboards be accessed by Internet 
clients? 
If your current deployment allows users to access Vision directly over the Internet (excluding 
access through a VPN), and users also need to access the Vision Performance Management 
dashboards over the Internet, do the following: 

 Configure your firewall to allow the port used by the Tableau Server software to be 
accessed. Note that this will typically require you to configure Tableau Server (and also 
Vision) with an SSL certificate. See “Configure Tableau Server for SSL (Optional)” on 
page 56 for more information. 

 Establish an Internet-accessible fully qualified domain name for that purpose (for 
example, visiondashboards.company.com). That domain name must be resolved both 
inside and outside the corporate network as the Tableau server name will be the same 
for all clients. 

Does your Vision deployment support multiple databases or multi-lingual? 
If your Vision deployment includes multiple databases (for example, a production database and a 
test database), or if you need to support Analysis Cubes and dashboards in multiple languages 
and you need to use Vision Performance Management with more than one of those databases, 
you must deploy a unique Data Warehouse/Cube database for each Vision database and/or 
language that you need to support.  

A single instance of Tableau Server supports multiple Analysis Cubes databases. To accomplish 
this, a unique Tableau “site” is created for each Analysis Cubes database during the workbook 
publishing process. See “About Tableau Sites” on page 64 for more information. 

Microsoft SQL Server Edition Dependencies 
Some of the Vision Analysis Cubes functionality is available only if you have Microsoft SQL 
Server Enterprise or Business Intelligence Editions installed. For details, see the “Microsoft SQL 
Server Edition Dependencies” section on page 7. 

 

Deltek provides OLAP (online analytical processing) services to assist you with the installation, 
configuration, and optimization of your SQL Analysis Cubes. These services consist of 
consulting, Web conferencing and training, installation guides, and reporting assistance.  

For more information, please contact your Deltek account manager at 
accountmanager@deltek.com. 

If you are using the Standard Edition, the limitation on Analysis Cubes functionality, in turn, 
imposes these limitations on the sample performance management dashboards: 

 These dashboards are not available: 

 Organization Manager Sample – Accounts Receivable Trending 

 Principal Sample - Accounts Receivable Trending 

 Executive Sample – Days Outstanding Metrics 

 Organization Manager Sample – Days Outstanding Metrics 

 Principal Sample – Days Outstanding Metrics 

 Project Manager Sample – Days Outstanding Metrics 

mailto:accountmanager@deltek.com
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 The Executive Sample – Accounts Receivable and Promotional Costs dashboard does 
not display the AR Trend chart, and the dashboard name is changed to Executive 
Sample – Promotional Costs, 

Summary of VPM Configuration Steps 
The following are the primary steps required to configure Vision Performance Management. If you 
are upgrading Vision Performance Management, skip ahead to Upgrading Tableau Software. 

Step Where to Perform Description 

1 All Deltek Vision 
servers 

Install or upgrade Vision to the current release. 

2 Vision Resource Kit 
on the Vision 
database server 

Deploy or re-deploy Deltek Vision Analysis Cubes. 

3 Server hosting 
Tableau Server Identify Tableau security configuration. 

4 Server hosting 
Tableau Server 

Install (or upgrade) and configure Tableau 9.3.5 Server. 

5 Server hosting 
Tableau Server 

Configure Tableau for SSL (optional). 

6 Server hosting 
Tableau Server 

Post Installation Configuration steps. 

7 Tableau Server Configure Trusted Authentication - if using Local (Tableau) 
Authentication. 

8 Tableau Server Configure Tableau Server Maintenance process 

9 Performance 
Management 
Application in Vision 

Publish sample workbooks to Tableau Server. 

10  Add user accounts to Tableau Server 

10a SQL Server 
Management Studio 
on the Vision 
database server 

Export Vision users to a .CSV file. 

10b Tableau Server 
Administration Import Vision users into Tableau Server. 

11 Vision Dashboard / 
Vision Reporting Test the performance dashboards. 
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Step Where to Perform Description 

12 User Desktops Install Tableau Desktop and necessary drivers. 

Tableau Security Configuration 
During the installation and configuration of Tableau Server, you must specify the type of 
authentication that you will use. Deltek suggests, but does not require, that this authentication 
match the authentication that you are using for your Vision implementation.  

 If you are using Windows Integrated Authentication with Vision, configure Tableau Server 
for Active Directory security.  

 If you are using Vision security, select Local (Tableau) authentication. This is configured 
via the User Authentication section of the Tableau Server Configuration dialog during the 
initial configuration of Tableau server and cannot be changed except to uninstall and re-
install the Tableau Server software. 

Active Directory 
After you add Active Directory users to Tableau Server (see “Add Domain Users” on page 61), 
your users can view performance dashboards both in Vision and directly in Tableau Server. 

If you are using Active Directory, make sure that you select Enable Automatic Login on the 
Tableau Server Configuration dialog box. This setting is required for seamless access to the 
dashboards from within Vision. 

If you have users in domains outside of the domain that Vision and Tableau Server are members 
of, and if those users require access to the Performance Management dashboards, a Domain 
Trust relationship must exist between the domains such that the server domain trusts the user 
domain. 

Local Authentication 
If you use Local (Tableau) authentication, the initial implementation of Vision Performance 
Management is a single user authentication. Only one Tableau user account is needed. 
Essentially, all of the Vision Performance Management dashboards are “shared” among all of 
your users, as authentication is performed under the context of a single user account. For more 
information, see “Add Local (Tableau) Users” on page 61. 

The following are the primary limitations of using Local authentication: 

 A feature of the performance dashboards, if you are using Active Directory, is that 
individual users can save personal customized views of the dashboards they are working 
with. With Local Authentication, a user can still save views but access to them is not 
restricted to that user. All users who display a dashboard have access to all views 
created for that dashboard. 

 Under Active Directory, users can access the performance dashboards from within Vision 
or directly on the server hosting Tableau Server. With Local Authentication, while it is 
possible to add your regular Vision users to Tableau Server and provide them access to 
the dashboards outside of Vision, the functionality of the dashboards will not be the 
same. For example, when you access dashboards directly through Tableau Server, the 
automatic role-based filters that are applied through Vision are not applied. As a result, 
the dashboards, by default, display all data rather than being pre-filtered. In addition, 
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users will have access to all of the Tableau Server functionality when accessing the 
dashboards directly. 

Changing Tableau Security Configuration 

 

Warning: If you install Tableau Server and then need to change the security configuration, it is 
not possible to save any Tableau configuration settings or data. You must fully reconfigure the 
environment. 

If you install Tableau Server and later need to change the security configuration (from Active 
Directory to Local Authentication or the reverse), you must uninstall the Tableau Server software 
and also remove the following Tableau Server installation folders: 

 C:\Program Files\Tableau (Substitute the appropriate installation drive letter and path, 
as appropriate.) 

 C:\ProgramData\Tableau (The ProgramData folder is a hidden Windows folder, so you 
will need to change your folder and view settings to display it.) 

Upgrading Tableau Software 
When upgrading to a version of Vision that has a new version of Tableau, the following Tableau 
components will also need to be updated.  

 Tableau Server software. This is part of the Deltek Vision Performance Management 
installation. 

 Tableau Worker software (distributed environments only). 

 TabCmd command line utility. As of Vision 7.6 the TabCmd utility is included as part of 
the Deltek Vision Web/Application tier installation and is located in the 
\Vision\Support\Utilities\TabCmd folder. 

 Tableau Desktop software. Available via the Deltek Software Manager. 

 

With the release of Vision 7.6, all Tableau software 8.0.2, 8.1.6, 8.2.0, 9.0.4 and 9.2.0  
components previously in use will require upgrading to Tableau 9.3.5.  Note that Tableau 9.3.5 
is only supported with Vision 7.5/7.6 so if you are on an older version of Tableau you will need to 
upgrade to Vision 7.5 or 7.6. 

In addition, Deltek is only supporting the Tableau Server 64-bit installation. If you previously 
installed Tableau 8.0.2 on a 32-bit server, a new 64-bit server will be required to install Tableau 
9.3.5. 
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In order to Publish workbooks from Vision with Tableau Server 9.3.5, an additional configuration 
step is necessary.  Follow the steps below to enable the wgserver process as described in the 
following Tableau KB article: 

http://kb.tableau.com/articles/knowledgebase/xml-endpoints-no-longer-available?userSource=1 

a. Open an Administrative Command prompt 

b. Change directory to <drive>:\Program Files\Tableau\Tableau Server\9.3\bin 

c. Run each of the following commands in order 

tabadmin stop 
tabadmin set wgserver.enabled true 
tabadmin set wgserver.xmlapi.enabled true 
tabadmin set worker0.wgserver.procs 1 
tabadmin configure 
tabadmin start 

 

The Performance Management installation will check for previous installations of Tableau 
software and prompts you to uninstall that software before continuing. 

Tableau software component upgrades are not typical software upgrades, in that you must 
uninstall the previous version before you can install the new one. However, the uninstall process 
does preserve all previously installed configuration settings. In the case of Tableau Server, this 
means that you will not lose any information (workbooks, users, or any other configuration 
settings). 

The Tableau software for Vision Performance Management is specifically branded for Deltek, and 
Deltek must be your source for that software.  

Do not attempt to upgrade Tableau with software from a source other than Deltek, such as from 
Tableau directly. 

Steps to Recover from a Failed Upgrade 

To recover from a failed upgrade of the Tableau Server software, complete the following 
steps: 

1. Ensure that you have a valid backup of the Tableau server database.  

See Set Up the Tableau Server Maintenance Process for more information. 

In the event of an upgrade failure where a maintenance process was not set up, the 
uninstall of Tableau Server does perform a backup, which will be located in the 
c:\ProgramData\Tableau\Tableau Server\uninstall-<version>.tsbak.  

If Tableau is on a different drive it will be in <drive>:\Program Files\Tableau\Tableau 
Server\uninstall-<version>.tsbak. 

2. Uninstall the failed Tableau installation and reboot the server. 

3. Rename the \Program Files\Tableau and \ProgramData\Tableau directories by 
appending OLD to each directory.  

4. Perform a clean installation of Tableau Server.   

The Tableau Server executable will be located in c:\Program 
Files\Deltek\Vision\Support\Tableau\TableauServer-<version>-Deltek-64bit.exe.  
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During the installation, make sure that the software is configured using the same security 
configuration as before (Active Directory or Local Authentication). 

When the installation completes and the service starts you will be prompted to create a 
new user account.  

5. Since you will be performing a restore of the previous Tableau data, just close the dialog 
box. 

6. Open an administrative command prompt to <drive>:\Program Files\Tableau\Tableau 
Server\<version>\bin. 

7. Restore the backup using the following commands, one at a time, which will restore the 
workbooks, configuration settings, and user information: 

tabadmin stop 
tabadmin restore <path to .tsbak file> 
tabadmin start 

Output from the tabadmin restore command should look similar to the following: 

===== Verifying backup manifest 

   -- Restoring service configuration 

Please enter the password for <Tableau administrative account>: 

   -- Restoring service data from backup file 

   -- Database restore completed. 

   -- running migrations 

===== Validating Database schema signature 

===== Schema Signature is valid 

===== Rebuilding Search Indices 

   -- Scheduling Background Job to Rebuild Search Indices 

Install and Configure Tableau Server  
Before you begin the installation process, read the Tableau Server 9.3 Administrator Guide. (This 
guide is available for download with the Deltek Software Manager, along with the other Vision 
Performance Management documentation.) Focus on the “Before you install…” and “Install and 
Configure” sections so that you have a thorough understanding of the installation and 
configuration process. 

The Tableau Server 9.3.5 installation is embedded in the Deltek Vision Performance 
Management for 7.6 installation (DeltekVisionPerformanceManagementFor76.exe). That installer 
installs the Deltek-specific Vision Performance Management configuration on the server and 
launches the Tableau Server installation at the end of that process.  

If you need to re-run the Tableau Server installation at a later time, the Tableau Server setup 
program is copied to <Vision Installation folder>\Support\Tableau. 

To install and configure the Tableau Server software, follow the instructions in the “Install and 
Configure” section of the Tableau Server 9.3 Administrator Guide. 
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Warning: If you install Tableau Server and later need to change the security configuration (from 
Active Directory to Local Authentication or the reverse), you must uninstall the Tableau Server 
software and also remove the Tableau Server installation folders. None of your configuration will 
be preserved. You must reinstall and reconfigure Tableau Server. 

The following steps summarize the process: 

1. Run Server Setup — This section describes how to install the Tableau Server software. 

2. Activate Tableau — Activate Tableau Server with the license key that Deltek provides. 

3. Configure the Server — Use the Tableau Server Configuration dialog box to configure 
Tableau Server for your environment. The following provide additional guidance for 
making key entries: 

 Server Run As User — This entry must be a domain account that has rights to the 
Analysis Cubes. Whether you are using Active Directory or Local authentication, this 
account must be a domain account with rights to the Analysis Cubes. 

 User Authentication — Select Use Active Directory (recommended) or Use Local 
Authentication (Tableau authentication). See “Tableau Security Configuration” on 
page 52 for more information. 

 Active Directory — If you are using Active Directory (domain) authentication, select 
Enable Automatic Login. This is a Deltek Dashboard requirement to ensure 
seamless display of the dashboards without requiring users to manually authenticate 
to Tableau Server. 

 Gateway — Choose the port that Tableau Server listens to for requests. Default is 80 
if IIS is not installed on the Tableau server, and 8000 if it is installed. 

 Open Port in Windows Firewall — If you select this setting, Tableau Server will 
open the specified port for incoming requests in Windows firewall. 

 Include Sample Data & Users — If you select this setting, Tableau sample 
workbooks are installed. Later you will need to delete them manually from Tableau 
Server. It is recommended that you not select this check box when you configure 
your production instance of Tableau Server. 

Configure Tableau Server for SSL (Optional) 
If your Vision server is configured to allow or require the use of SSL (https), you must also 
configure the server hosting Tableau Server with an SSL certificate. As it does for reporting, 
Vision requests dashboards using the same URL prefix (http or https) that was used to access 
Vision. 

If some users access Vision using SSL (https) and the server hosting Tableau Server is not 
configured for SSL, those users cannot display the dashboards. However, users accessing Vision 
internally using http will be able to access Tableau dashboards using SSL. 

To configure the Tableau server for SSL, complete the following steps 
1. Refer to the “SSL” section in the Tableau Server 9.3 Administrator Guide. Also refer to 

the following Tableau knowledgebase article for steps on configuring SSL: 

http://kb.tableausoftware.com/articles/knowledgebase/creating-ssl-certificate-and-key-
tableau-server 

http://kb.tableausoftware.com/articles/knowledgebase/creating-ssl-certificate-and-key-tableau-server
http://kb.tableausoftware.com/articles/knowledgebase/creating-ssl-certificate-and-key-tableau-server
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2. When you configure the server hosting Tableau Server for SSL, it only accepts requests 
on the default SSL (https) port of 443. Tableau does not support the configuration of a 
non-standard SSL port. 

3. If Tableau Server is installed on the Vision Web or application server (or any other server 
that is using port 443 for SSL communication), Tableau Server cannot be configured for 
SSL because it requires port 443. Refer to the next section for more details on these 
issues. 

 

If you are using an SSL certificate obtained from an Internal Certificate Authority (for example, 
Microsoft Active Directory Domain CA) you will receive errors when you attempt to publish 
workbooks. See “Chapter 7: Troubleshoot the Performance Dashboard Deployment” on page 67 
for more on how to resolve this issue. 

Problematic Vision / Tableau Tier Configurations with SSL 
As indicated previously, Deltek strongly recommends that the Tableau Server reside on its own 
dedicated server. If you opt to install Tableau on an existing Vision tier and you will be using SSL, 
please note the following limitations which result from the fact that Vision server-side calls will 
always use HTTP when Vision is configured for SSL. Client-side calls will always use SSL if so 
configured. 

 A single server installation of Vision and Tableau where SSL will be used cannot be 
made to work and is therefore unsupported. 

 Tableau and SQL Reporting Services installed to the same server.  It is possible for this 
configuration to work.  Note the following: 

 Tableau and reporting services need to be configured using different HTTP ports. 

 You will need to configure a reverse proxy for reporting configured for SSL 
Offloading. In this configuration, Reporting Services will not be configured for SSL so 
you will able to configure Tableau for SSL. Refer to Chapter 1 in the Advanced 
Technical Configuration Guide for more information on the use and configuration of 
ARR (Application Request Routing) Reverse Proxy.   

Both of these tier configuration can be supported via the Use HTTPS for SSRS Connection 
Weblink option on the Report Server tab.  When you select this option, Vision will send server-
side calls to reporting services over SSL.  

 

It is still necessary for both Vision and SSRS (#1 above) or just SSRS (#2 above) to listen on a 
non-standard SSL port (for example, 444) as Tableau Server requires port 443 for SSL 
communication. 

Post Installation Configuration 
Several additional configuration steps are required after the initial Tableau Server installation and 
configuration process. These steps are listed below: 

1. IMPORTANT: In order to Publish workbooks from Vision with Tableau Server 9.3.5, an 
additional configuration step is necessary.  Follow the steps below to enable the 
wgserver process as described in the following Tableau KB article: 
 
http://kb.tableau.com/articles/knowledgebase/xml-endpoints-no-longer-
available?userSource=1 

a. Open an Administrative Command prompt 
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b. Change directory to <drive>:\Program Files\Tableau\Tableau Server\9.3\bin 

c. Run each of the following commands in order 

tabadmin stop 
tabadmin set wgserver.enabled true 
tabadmin set wgserver.xmlapi.enabled true 
tabadmin set worker0.wgserver.procs 1 
tabadmin configure 
tabadmin start 

2. Verify that the Analysis Services OLE DB drivers are installed on the server hosting 
Tableau Server.  

Tableau Server cannot connect to the Analysis Cubes database without these drivers. 
The Analysis Services OLE DB drivers are available in the SQL Server Feature Pack for 
your version and Service Pack of SQL Server. Be sure to use the correct version for your 
installation of SQL Server. Links for the most recent SQL Server Service Pack Feature 
Packs are listed below: 

SQL 2012 SP3 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=49999  
x64 - ENU\x64\SQL_AS_OLEDB.msi 
 
SQL 2014 SP1 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=46696 
x64 - ENU\x64\SQL_AS_OLEDB.msi 
 
SQL 2016 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=52676 
x64 - ENU\x64\SQL_AS_OLEDB.msi 

If the drivers are not installed, the workbook publishing step will fail. 

3. If you will be publishing workbooks that connect directly to the Vision database, you must 
ensure the SQL Server Native Client drivers are installed on the Tableau Server.   

The SQL Server Native Client drivers are available in the SQL Server Feature Pack for 
your version and Service Pack of SQL Server. Be sure to use the correct version for your 
installation of SQL Server. Links for the most recent SQL Server Service Pack Feature 
Packs are listed below: 

SQL 2012 SP3 Feature Pack 
https://www.microsoft.com/en-us/download/details.aspx?id=49999 
x64 - ENU\x64\sqlncli.msi 

SQL 2014 / 2016do not ship with an updated SQL Server Native Client installer.  Use the 
SQL 2012 Sp3 Native Client installer (https://msdn.microsoft.com/en-
us/library/ms131321.aspx). 

4. Create or obtain the Tableau System Administrator credentials that will be used to 
publish the sample Tableau workbooks.  You will enter these credentials along with the 
Tableau Server connection information in the Performance Management application in 
Vision.  See Vision online help for more information. 

See “Add an Administrator Account” in the Tableau Server 9.3 Administrator Guide.  

5. Publish sample workbooks to Tableau Server using the Performance Management 
application in Vision located under Configuration » General.  
See the Vision on-line help system for information on publishing workbooks. 

https://www.microsoft.com/en-us/download/details.aspx?id=52676


Chapter 6: Performance Management Dashboards Installation and Configuration 

 

Installation and Configuration Guide for Performance 
Management 59 

 

The Publishing process was formerly completed via the Resource Kit application on the 
database server. This process has been moved to the Vision application. You still use the 
Resource Kit to create the Analysis Cubes. 

6. Import (or add) your Vision users to Tableau Server.  

See ”Add User Accounts to Tableau Server” on page 61 in this guide. 

7. If you use Local Authentication, add the IP addresses for all Vision Web/application 
Servers to the Tableau Server trust configuration. 

See “Trusted Authentication” in the Tableau Server 9.3 Administrator Guide. (Refer to 
Configuring Trusted Authentication for the specific steps later in this document.   

8. Set up anti-virus exclusions. 

In order to increase performance and also minimize issues during Tableau Server 
installations and upgrades, follow the steps in the article below to set exclusions on the 
Tableau Server directories: 

http://kb.tableausoftware.com/articles/howto/improving-performance-by-using-antivirus-
exclusions  

9. Set Up the Tableau Server Maintenance Process to ensure the following: 

 The application is always fresh (restarted periodically). 

 You have a good backup. 

 Logs are cleaned up. 

By default, your Vision IIS application pool recycles at 12:15 a.m. every night and the 
Analysis Cubes are refreshed at midnight. Use the procedure later in this chapter to do 
the same for your Tableau server.   

Configure Trusted Authentication (if applicable) 
Follow the steps below to configure trusted authentication for Tableau Server if your chosen 
security model was Local Authentication: 

To configure trusted authentication, on the server hosting Tableau Server, complete the 
following steps: 

1. Open an Administrative command prompt. 

2. Change directory to your Tableau installation directory. 

The default installation directory is C:\program files\Tableau\Tableau Server\8.2\bin. 

3. Stop the Tableau Server with the following command: 

tabadmin stop 
4. Add the Vision Web server IP addresses to the Tableau trust list with the following 

command: 

tabadmin set wgserver.trusted_hosts "<Trusted IP Addresses>" 
For example, if you have three Vision Web/application servers with the IP addresses 
192.168.1.101, .102 and .103, enter the following: 

tabadmin set wgserver.trusted_hosts "192.168.18.2.101, 192.168.1.102, 
192.168.1.103" 

http://kb.tableausoftware.com/articles/howto/improving-performance-by-using-antivirus-exclusions
http://kb.tableausoftware.com/articles/howto/improving-performance-by-using-antivirus-exclusions
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Be sure you enter a space after each of the commas that separate the IP addresses. 

5. Commit the configuration with the following command: 

tabadmin configure 
6. Restart Tableau Server with the following command: 

tabadmin restart 

Maintain the Tableau Server 

 

In some situations the nightly data refresh of the Analysis Cube will cause Tableau workbooks to 
show errors indicating that there were structural changes to the database. It has been identified 
that Analysis Services will disconnect sessions in certain situations and Tableau server will not 
automatically regenerate a session so, while the error is indicative of structural changes, the 
actual issue is due to disconnected sessions .   

However, in all cases of this error it has been shown that restarting the Tableau server will 
resolve the problem. As such, Deltek highly recommends configuring the Tableau Server 
Maintenance script be run on a scheduled nightly task to start after the analysis cubes have 
been refreshed. For example, if your Analysis Cubes take two hours to refresh and that job 
starts at Midnight, schedule the Tableau Maintenance script to run at 3am. 

To refresh and back up the Tableau server and remove old log files, complete the 
following steps: 

1. Copy the batch script below into Windows Notepad. 

2. Modify the backup locations (highlighted in the script below) as appropriate for your 
server configuration. 

3. If necessary, modify the file age parameter in the forfiles command as appropriate for 
your backup strategy. If you do not change the current parameter value, the forfiles 
command will look for and delete files older than 30 days. 

4. Save the file as TableauCleanup.bat (or something similar) in the Tableau Server bin 
directory (c:\program files\Tableau\Tableau Server\<version>\bin). 

5. Use Windows Task Scheduler to schedule the batch file to run after your Analysis Cubes 
are refreshed.  

 

Refer to the following Microsoft Technet article if you are unfamiliar with Task 
Scheduler: (http://technet.microsoft.com/en-us/library/cc721871.aspx). 

Tableau Server Maintenance Script 
@echo off 
forfiles -p "e:\TableauBackup" -M *.* /D -30 /C "cmd /c del @path" 
For /f "tokens=2-4 delims=/ " %%a in ('date /t') do (set mydate=%%c-%%a-%%b) 
For /f "tokens=1-2 delims=/:" %%a in ("%TIME%") do (set mytime=%%a%%b)  
::echo %mydate%_%mytime% 
tabadmin stop 
tabadmin ziplogs -l -n -f 
ren logs.zip logs_%mydate%_%mytime%.zip 
move /Y logs*.zip e:\TableauBackup\ 
tabadmin backup tableau_backup 

http://technet.microsoft.com/en-us/library/cc721871.aspx
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ren tableau_backup.tsbak tableau_backup_%mydate%_%mytime%.tsbak 
move /Y tableau_backup*.* e:\TableauBackup\ 
tabadmin cleanup 
tabadmin start 
tabadmin cleanup 

 

The forfiles syntax may be different for your operating system. Test the script to make sure that 
command is correct for your environment. 

Publishing Tableau Sample Workbooks  
After you configure the Vision Analysis Cubes and install and configure Tableau Server, the next 
step is to publish the Deltek-provided sample workbooks to Tableau Server using the 
Performance Management application in Vision.  Refer to the Vision online help for more 
information on this process. 

Prerequisite 
Before publishing workbooks you must first install the Tableau Command Line Utility on the 
Vision web/application server. The Vision installation copies the Tableau Command Line Utility 
installer to <Vision Installation Directory>\Support\Utilities\TabCmd. Run this setup process on 
your Vision web/application server and accept the default installation location. If, when you 
attempt to publish workbooks, you receive errors, refer to “Chapter 7: Troubleshoot the 
Performance Dashboard Deployment” on page 67.  

Since the Performance Management application and workbook publishing process is now part of 
the Vision application, refer to the Vision on-line help system for information on workbook 
publishing. 

Add User Accounts to Tableau Server 
You can add users to Tableau Server using an export-import process, or you can set up users 
manually in Tableau Server one at a time. You must be either a System Admin or Site Admin to 
add users to Tableau Server. 

Add Domain Users 
If you use Active Directory security, you must add your domain users to Tableau Server so those 
users can access the Vision Performance Management dashboards in Vision. Once your Vision 
users have been added as Tableau users, they can access the dashboards either from Vision or 
directly through Tableau Server. 

Add Local (Tableau) Users 
If you have configured Tableau Server to use Local Authentication, all access to dashboard 
content occurs under the context of a single Tableau security account. That account is configured 
as a System Administrator in Tableau Server and is the account used to publish the workbooks. 
This configuration makes it impractical, from a security perspective, to provide your users with 
access to Tableau Server outside of Vision because you would have to provide all of your users 
with the username and password of this System Administrator account.  

Though the implementation for Local (Tableau) authentication does not provide a direct user-to-
user mapping, you can still create Local (Tableau) security users using your users’ Vision security 
usernames, which can then be used for accessing Tableau Server from outside of Vision. Refer 
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to “Local Authentication” on page 52 for information on limitations associated with this 
configuration. 

Export Vision Users 
In SQL Server Management Studio (SSMS), execute the following SQL queries against your 
Vision database to create a .csv export file containing all of your Vision users. 

The users exported are filtered in the following ways: 

 If you use Local (Tableau) authentication — This query only includes "non-disabled" 
Vision Security (non-Active Directory) logins. 

 If you use Active Directory authentication – This query only includes "non-disabled" 
Active Directory logins for which the domain has been specified in Vision security 
configuration. 

All users who meet this criteria are exported. 

In multiple database/cube, multiple language implementations, you may need to break this export 
up into site level users and import at the site level in Tableau rather than the server level. (At the 
server level, users have access to all sites.) More information on this is provided below. 

After you have executed the query in SSMS, you can right-click in the results pane, select Save 
results as, and then choose a .csv file. 

Local Authentication Query 
SELECT  s.username as Username,  
'password' as Password,  
'"' + e.firstname + ' ' + e.lastname + '"' as Fullname, 
'Interactor' as LicenseLevel, 
'None' as Administrator, 
'No' as Publisher 
FROM EM e  
INNER JOIN Seuser s  
 ON e.Employee = s.employee  
WHERE s.DisableLogin <> 'Y' and s.Password <> 'integrated' 
 

 

When using Local (Tableau) authentication, a password is required. The password column in the 
export file for all users will default to “password”. After they log in to Tableau Server, users will 
need to change their Tableau Server password under User Preferences or you can modify the 
export file and set a password for yours users: 

Active Directory Query 
SELECT  s.Domain + '\' + S.username as Username,  
' ' as Password,  
'"' + e.firstname + ' ' + e.lastname + '"' as Fullname, 
'Interactor' as LicenseLevel, 
'None' as Administrator, 
'No' as Publisher 
FROM EM e  
INNER JOIN Seuser s  
 ON e.Employee = s.employee  
WHERE s.DisableLogin <> 'Y' and s.Password = 'integrated' 
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Due to a bug in Tableau 9.0, you will need to change the domain name returned from the query 
from the Netbios domain name (domain nickname) to the Fully Qualified Domain Name.   For 
example, use company.domain.com\<user> instead of just company\<user>. 

 

CSV File Format 
The format of the .csv file is as follows: 
Username,Password,Full Name,License Level,Administrator,Publisher 

Example Active Directory export file: 
INETTEST2K8N\VPMUser1,,”VPM User 1”,Interactor,None,No 

Example Local (Tableau) export file: 
ADMIN,password,"William Apple",Interactor,None,No 

JAMESB,password,"James Bartlett",Interactor,None,No 

The table below describes the data in the export file in more detail: 

Data Item Description 

Username  This field contains the user’s login name.  

If you use Active Directory, the format is <Domain>\<Username>.  

If you use Local (Tableau) authentication, the format is <username>.  

Password This field contains the user’s login password, if applicable. 

If you use Active Directory, this field is blank.  

If you use Local (Tableau) authentication, this field contains password, the 
default password. 

Users can change their passwords on the User Preferences page after they 
successfully log in to Tableau Server. 

Full Name This field contains the full name of the user, for display purposes. 

License Level This field contains the user’s Tableau license level that controls the user’s 
level of access to the workbooks: Interactor, Viewer, or None.  

The default value is Interactor. 

Administrator This field contains the user’s Tableau Server administrative level: System, 
Site, or None. 

The default value is None. 

Publisher This field indicates if the user has the access necessary to publish 
workbooks: Yes or No. 

The default value is No. 
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You can modify the values in the License Level, Administrator, and Publisher fields before 
performing the import if you have specific users who require additional rights. You can also 
modify rights in Tableau after the import. 

Refer to the Tableau Online help for additional information: http://onlinehelp.tableau.com/   

Import Users into Tableau Server 

About Tableau Sites 
The Default site is created by the Tableau Server configuration. Vision does not use the Default 
site. Publishing Tableau workbooks from Vision creates a site name in the format <Database 
name>_<language> (for example, Vision_en-US for a database named Vision using English 
United States as the language). A new site conforming to this naming convention is created each 
time workbooks are published for a new database/language combination. 

Performing the User Import 
You can perform the import at the Default site level and then modify the site membership for a 
single user or groups of users after the import using Site Membership, or you can import at the 
site level directly. If the account performing the import is only a site administrator in Tableau, then 
you can only import users to that site. 

To perform the import, complete the following steps: 
1. Open a browser and enter the URL for Tableau Server. 

2. Log in to Tableau Server, select your site, and click OK. 

If you use Active Directory authentication with Enable Automatic Login enabled, you are 
immediately prompted to choose the Tableau site to log in to. If you use Local (Tableau) 
authentication, a login prompt displays initially. 

3. Click the Server menu item and then Users if you are importing users to the server level 
or select your Site name and then Users to import users into that site. 

If you import users into Server » Users and have included a license level in your import 
file it will be ignored and all users will be imported unlicensed. After the import you can 
mass select users and change the site membership and site role (license level). 
Click the + Add Users button 

4. Click the Import from File option. 

 

5. Click Browse and select the.csv file. 

6. Click Import Users. A dialog box will display indicating the success or failure of the 
operation.   

7. Click Exit when the process is completed. 

After the Import 
As indicated previously, you may have several Vision Analysis Cubes, each with its own Tableau 
site. If you import all users at the Default site of Tableau Server, follow the steps below to modify 
the site membership for your users. 

http://onlinehelp.tableau.com/
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If the user is not added to the site membership for the site that maps to the Analysis Cube that 
they are accessing, they cannot access the dashboards. For example, if you add all of your users 
to the English site (en-US) and a user logs into Vision as French Canadian (fr-CA), that user will 
not be able to access the dashboards until you add them to the <Database name>_<fr-CA> site 
in Tableau Server. 

To modify the site membership, site role (license level), or administrator rights for one or more 
users, select the users and select the Actions menu to set the various options. 

Ongoing User Maintenance 
There is no “synchronization” functionality between users in Vision and Tableau Server. As new 
users are added to, removed from, or disabled in Vision, you must add, remove, or disable them 
manually in Tableau Server. 

Test your Tableau Server Installation/Configuration with Vision 
When you have completed the Tableau Server configuration, user creation, and workbook 
publication, test access to the dashboards in Vision to validate the configuration. 

To test your configuration, complete the following steps: 
1. Log in to Vision and access the Vision Dashboard. 

2. On the Vision Dashboard toolbar, click Configure and Add Web Dashpart.  
3. In Web Part Name on the Add Web Dashpart dialog box, enter a name for the dashpart. 

4. In Address Type, select Performance Management Dashboard. 

5. In Dashboard, select one of the listed performance dashboards. 

6. Click Save to add the dashboard to your Vision Dashboard as a dashpart. 

Install Tableau Desktop on User Workstations 
For those users that will be creating custom dashboards using the Tableau Desktop tool you will 
need to install the Tableau Desktop software as well as the necessary SQL Server drivers 
(Analysis Services OLE DB and/or SQL Native Client). The Tableau Desktop software can be 
downloaded from DSM. See Post Installation Configuration for download locations for the 
appropriate drivers. 

Access Tableau from Outside of Vision 
You can access Vision Performance Management dashboards from within Vision either as Web 
dashparts on the Vision Dashboard or through Vision Reporting. You can also access the same 
dashboards directly from Tableau Server using a browser. 

Tableau Server Configured for SSL 
If Vision is configured to use SSL, Tableau Server must be configured for SSL also. If users will 
access Tableau Server from outside your corporate network, you must also make the necessary 
firewall modification to allow access to Tableau Server from the internet. 
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Access Tableau Desktop from the Internet 
If users need to access Tableau Desktop from the internet to create custom workbooks, with the 
Analysis Cubes behind a firewall, you must configure the OLAP data pump as defined in “Chapter 
5: Configure Analysis Cubes for Internet Accessibility” on page 38. Those Tableau Desktop user 
will use the same URL that is used in Excel in that chapter. 

Note on Local Authentication/Vision Security 
As noted earlier in this guide, if you use Vision Security and Tableau Local authentication, the 
behavior of the dashboards is different when accessed outside of Vision. See “Local 
Authentication” on page 52 for more information. 
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Chapter 7: Troubleshoot the Performance 
Dashboard Deployment 
Errors received when publishing the workbooks to Tableau Server may not provide sufficient 
information to identify the problem.  For those issues you will need to obtain the Tableau Server 
logs.  The following Tableau knowledgebase article provides the instructions: 

http://onlinehelp.tableau.com/current/server/en-us/help.htm#logs_archive.htm 

Solutions to a variety of known problems are included below: 

 

Problem: 
When attempting to publish workbooks you may receive an error in the Workbook_<Database> 
log  indicating the following: 

*** This data connection is not licensed for use with Deltek Vision Performance Management 

During the workbook publishing process an MDX (Analysis Services) Query is executed to ensure 
that you are attempting to use Tableau Server against a valid Deltek data source and that query 
is failing. We receive this error because your Tableau Server is only licensed to connect to your 
Deltek Vision database or Deltek Vision Analysis Cubes. 

Solution: 
Ensure that the cubes have been built properly and that the Tableau Server Run As account has 
rights to the Analysis Server and/or Vision database.  If the error persists, restart Tableau server. 

 

Problem: 
Attempting to publish workbooks from Vision may result in the following error:  

The remote server returned an error. (500) Internal Server Error  

A review of the application event log on the Vision application server shows Event Code 3001 
with the following exception information: 

Exception information:  

    Exception type: HttpException  

    Exception message: Request timed out. 

Solution: 
Edit the Vision web.config file and increase the ExecutionTimeout value in the httpRuntime 
element.  The default value in 900 seconds (15 minutes). 

 

Problem: 
Attempting to publish workbooks in Vision 7.3 and later, you may receive an error indicating that 
the publishing failed and you will see the following error written to the Workbook_<database>.log 
file in the Vision\Logs folder on the web/application server: 
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ERROR: System.ArgumentException: An item with the same key has already been added. 

This error is caused because a custom workbook was published that had the same name as one 
of the Deltek-provided sample workbooks. For example, you may have uploaded one of the 
Deltek sample workbooks using the Upload button in the Performance Management application 
in Vision.   

This was fixed in CU#001 of Vision 7.3. You can no longer upload Deltek sample workbooks 
using the Upload button. 

Solution: 
You will need to identify and delete the records in the FW_CustomFile table that match the name 
of any of the Deltek sample workbooks.  All of the Deltek sample workbooks can be found in the 
Vision\Workbooks folder on the web/application server.  The following query will help you identify 
the custom workbook(s): 

Select * from FW_CustomFile where type = ‘TWB’ 

This table also hold custom report files (type = ‘RPT’). 

 

Problem: 
When you attempt to publish workbooks, you receive the following errors: 

*** The drivers necessary to connect to the database server '<Server>' are not properly 
installed on Tableau Server. Visit http://www.tableausoftware.com/drivers to download driver 
setup files. 

Database error 0x80040154: Class not registered 

Unable to connect to the server. Check that the server is running and that you have access 
privileges to the requested database. Operation Canceled. 

Solution: 
The Analysis Services OLE DB drivers are not installed on the Tableau server. Install the correct 
drivers as indicated in “Post Installation Configuration” on page 57 and restart Tableau Server. 

 

 

Problem: 
When you attempt to publish workbooks using Vision, you receive an error indicating that the 
Tableau Command Line Utility cannot be found. 

Solution:  
Make sure that the TabCmd utility is installed and that the TabCmdPath registry value is correct. 

The TabCmdPath registry location is HKLM\Software\Deltek\Vision.  

TabCmdInstaller.exe is installed with the Deltek Vision web/application tier installation to the 
following location: 

C:\Program Files\Deltek\Vision\Support\utilities\TabCmd 

The TabCmdPath registry entry may need to be changed after Tableau upgrades as the TabCmd  
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utility will need to be upgraded.  The default path is listed below and may need to be edited to 
update the Tableau version: 

C:\Program Files\Tableau\Tableau Server\<version>\extras\Command Line 
Utility\tabcmd.exe 

Replace <version> with the current version of Tableau. 

 

Problem: 
When you attempt to publish workbooks you receive and error message similar to the following: 

Errno::ENOENT: No such file or directory – (followed by a long stack trace). 

Solution: 
The account being used to publish the workbooks is configured as a roaming profile. Use an 
account that does not have a roaming profile. 

 

Problem: 
When you attempt to publish workbooks you receive and error message similar to the 
following:*** handshake alert: unrecognized name 

Solution: 
A previous version of the Tableau Command Line Utility is installed. Uninstall the previous 
version and install the current version. 

 

Problem: 
You use Active Directory authentication, and the Tableau Logon prompt displays when you 
attempt to view a Performance Management dashboard. 

Solution: 
Tableau Server is configured for Active Directory authentication, and Enable Automatic Login is 
not selected in the Tableau Server configuration. Run the Tableau Server configuration utility to 
enable automatic login. 

 

Problem: 
You use Local (Tableau) authentication and receive the “Deltek Vision cannot generate trusted 
ticket” error. 

Solution: 
The Vision Web/application server is not in the Tableau Server trust list. Add the Web/application 
server IP address to the Tableau Server trust configuration, as indicated in “Configure Trusted 
Authentication (if applicable)”. 
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Problem: 
You receive a “*** certificate verify failed” error publishing workbooks when an internal domain CA 
issued SSL certificate is used. 

Solution: 
On the Performance Management application in Vision, clear the Validate SSL Certificate check 
box so that TabCmd does not validate the certificate during the publish process. 

 

Problem: 
Vision is accessed using SSL (https), the Tableau Server is not yet configured for SSL, and the 
following message displays: 

“Unable to load Performance Management dashpart. When Vision is accessed using SSL, 
your Performance Management (Tableau) server must also be configured to use SSL.” 

Solution: 
If Vision can be accessed through SSL, even if only for a small subset of users, Tableau Server 
must be configured for SSL, or those users cannot access the dashboards. 

 

Problem: 
When accessing the Performance Management dashboards from the Vision Dashboard, you may 
receive a login prompt or a message indicating “Navigation Cancelled”. 

Solution: 
If using SSL and Active Directory, browser security settings must be set to Automatic Logon 
with current username and password. This can be changed under the browser security zone 
configuration. 

 

Problem: 
You receive errors when you publish workbooks. 

Solution: 
Review the Workbook Publishing Log file (<Vision installation 
folder>\Logs\Workbooks_<database>.log) for error details. Below are suggestions for some 
specific error conditions: 

 *** Internal Error Tableau Server encountered an unknown error. Operation 
Canceled 
Attempt to load the processed workbook in Tableau Desktop. If there are issues with 
KPIs, dimensions, or measures, Tableau Desktop identifies them with an error. 

If the error indicates that a field is missing (for example, “There is no field name <field 
name>”), then it is likely that the default Analysis Cubes configuration application in 
Vision has been modified to remove various objects (measures, dimensions, or KPIs).   

Follow the steps below to ensure that all required objects are available in the cube: 



Chapter 7: Troubleshoot the Performance Dashboard Deployment 

 

Installation and Configuration Guide for Performance 
Management 71 

 

1. Log in to Vision and access the Analysis Cubes application under Configuration » 
General. 

2. Click the Restore Required Configuration button. This ensures that all objects 
required by the workbooks are available in the cube. 

3. Save your changes 

4. In the Vision Resource Kit on the database server, re-run Steps 4 and 5 to re-apply 
cube configurations and refresh the cubes. 

 *** Internal Error Tableau Server encountered an unknown error. Operation 
Canceled 
 Another reason for this error could be low memory conditions on the Tableau 
server during the publish process. If opening the workbook in the desktop tool does not 
yield any errors and memory utilization on the Tableau server exceeds 90%, try restarting 
the Tableau Server process and attempt the publishing again.  

 *** execution expired 
This error indicates that the gateway timeout on the Tableau server needs to be 
increased. To increase the timeout limit, navigate to the Tableau bin directory in an 
Administrative command prompt on the Tableau server, and run the following commands: 

tabadmin stop 

tabadmin set gateway.timeout 3600 

tabadmin set vizqlserver.querylimit 3600  

tabadmin configure  

tabadmin start 

 

Problem: 
If you use Active Directory with Tableau Server and you need to add user accounts from a trusted 
domain, the first time you attempt to add the user using the standard domain nickname (for 
example DOMAIN\User) the Tableau server will not be able to recognize the domain nickname.  

In this situation, you must enter the domain using the fully qualified domain name (for example 
DOMAIN.COMPANY.COM\User).  

In addition, because of a defect in Tableau Server, it assumes that the first word before the period 
in the fully qualified domain name is the domain nickname (DOMAIN for the example above). This 
may or may not be correct for your organization. If it is not correct, users cannot authenticate to 
Tableau Server until you correct the domain nickname. 

Solution: 
The editing of the domain nickname was previously available through the Tableau Administration 
application. As of Tableau 9.0, you must use the TabCmd utility. 

To resolve this problem, complete the following steps: 
1. Ensure that the TabCmd utility is installed on the Vision application server. 

2. From an Administrative command prompt on the Vision application server, change 
directory to <drive>:\Program Files\Tableau\Tableau Server\9.0\extras\Command Line 
Utility. 
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3. Enter the following Tableau command: 

tabcmd listdomains --username <Tableau administrator domain username> --server 
<Tableau server> 
 
You will be prompted for the password for the Tableau administrator domain username. 

The result of this command will be similar to the following: 
 
===== Listing domains from the server... 

===== 

ID      Nickname                Name 

1       local                   local 

2       <domain1>         <FQDN of domain1>. 

3       <domain2>         <FQDN of domain2> 

4. Identify the domain ID where the Nickname is incorrect. 

5. Enter the following Tableau command: 

tabcmd editdomain --id 3 --nickname "<correct nickname>" 

The result of this command will show the updated Domain nickname and your users from 
that domain should now be able to login automatically. 

 

Problem: 
When you attempt to publish workbooks, you receive a message indicating that no workbooks 
were published. The Resource Kit log indicates the following error: 

M<Date> (time) - <User> - ERROR PUBLISHING WORKBOOK Business Development 
Manager Sample - Opportunity Wins and Projections.twb: 

  *** The server is not licensed to connect to 'Microsoft Analysis Services' data sources. 

Operation Canceled. 

Solution: 
This occurs when the Deltek-provided Tableau license keys were added to the Tableau Server 
configuration, but the Tableau services were not restarted. Restart the Tableau services. 

 

Problem: 
When you attempt to load a VPM dashboard in Vision you receive a “Forbidden Action” message 
indicating you are not authorized to perform this action. 

Solution: 
This occurs when the vizqlserver.protect_sessions setting has not been disabled. Complete the 
steps below on the server hosting Tableau Server to disable this setting: 

1. Open an Administrative command prompt. 
2. Change directory to your Tableau installation directory. 



Chapter 7: Troubleshoot the Performance Dashboard Deployment 

 

Installation and Configuration Guide for Performance 
Management 73 

 

3. The default installation directory is C:\program files\Tableau\Tableau Server\8.2\bin. 
4. Set vizqlserver.protect_sessions to false using the following sequence of commands: 

tabadmin stop 

tabadmin set vizqlserver.protect_sessions false 

tabadmin configure 

tabadmin start 

 

Problem: 
When you attempted to load a VPM dashboard in Vision, you received a “Session Ended by 
Server” error indicating a Analysis Services database error 0x800004005, “Current session is no 
longer valid due to structural changes in the database.” 

Solution: 
This occurs when the Tableau server process has not been restarted since the last Analysis 
Cubes refresh. Refer to “Set Up the Tableau Server Maintenance Process” on page 59 for the 
steps to ensure that your Tableau server is backed up and restarted each night. 

It has been identified that Analysis Services will disconnect sessions in certain situations and 
Tableau server will not automatically regenerate a session so, while the error is indicative of 
structural changes, the actual issue is due to disconnected sessions .   

 

Problem: 
When attempting to upload a custom workbook from Vision you receive an error indicating that 
the workbook publishing failed.  

A review of the workbook log on the Vision server shows the following error: 

<date> (time) - ADMIN - ERROR: System.Xml.XmlException: Root element is 
missing. 

Solution: 
This occurs when attempting to upload a custom workbook that has been saved as a .twbx file.  
Only .twb files are supported with Deltek Vision.  

You can convert or save the .twbx as a .twb file using the Tableau Desktop tool and attempt to 
publish the workbook again. 

 

Problem: 
Workbook publication fails with the first workbook, and the Workbook Publishing log file contains 
the following error: 

*** Analysis Services database error 0x80004005: The following system error occurred:  A 
connection attempt failed because the connected party did not properly respond after a 
period of time, or established connection failed because connected host has failed to 
respond. 

Unable to connect to the server. Check that the server is running and that you have access 
privileges to the requested database. 
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Errors occurred while trying to load the workbook "BusinessDevelopmentManagerSample-
OpportunityWinsandProjections". The load was not able to complete successfully. 

Operation Canceled. 

Solution: 
A firewall between the Tableau server and SQL Analysis Services server is preventing 
communication. (The firewall can be a software-based firewall running on the servers such as 
Windows Firewall.) Modify the firewall configuration to allow the following:  

 Inbound Rule – Allow TCP port 2383 Inbound to the SQL Analysis Services server 

 Outbound Rule – Allow TCP port <Tableau server port> from the SQL Analysis Services 
server, where <Tableau server port> is the port on which Tableau Server listens for 
requests. That port is specified in the Tableau Server Configuration Utility. 
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Appendix A: Configure Vision Analysis Cubes for 
a SQL Server Clustered Environment 
You can configure Vision Analysis Cubes to operate in a SQL Server clustered environment using 
the Vision Resource Kit. 

Deploy Vision Analysis Cubes to a SQL Cluster 
This process requires that both nodes in the cluster be rebooted. Deltek recommends that you 
schedule this process during an appropriate maintenance window, ideally after working hours. 

To deploy Vision Analysis Cubes to a SQL cluster, complete the following steps: 
1. Install and configure a working SQL Server cluster. 

2. Perform a Vision database tier-only installation on both nodes to the same installation 
path on the local server.  

Do not install Vision to the shared cluster storage. 

3. Reboot both nodes.  

This is necessary to ensure that the environment variables exist and are active on both 
nodes in case of fail-over. 

4. Build the Vision data cubes on Node1 of the cluster using the Vision Resource Kit: 

a. Run the Resource Kit using Run as Administrator.  
See “Open the Vision Resource Kit” on page 18 for specific instructions. 

b. Click the Resource Kit Database tab, and connect to your server using the cluster 
virtual name (not the name of the cluster node you are running it on). 

c. Click the Analysis Services tab (a sub-tab of the Database tab).  

d. On the Analysis Services tab, click the Step 1: Check Prerequisites button to 
confirm that all the prerequisites are installed. 

For detailed instructions and screen shots for each of the steps on the Analysis 
Services tab, see “Check Prerequisites” on page 19. 

e. On the Analysis Services tab, click the Step 2: Setup button to create the data 
warehouse and Analysis Services database. 

f. Grant the SQL Server Agent services account database owner (db_owner) rights to 
the data warehouse database that was created as part of running Resource Kit Step 
2: Setup.  

The data warehouse will be the name of your Vision database with DW appended to 
it. 

g. On the Resource Kit Analysis Services tab, click the Step 3: Apply System Labels 
to Cubes button to apply your custom field labels to the data warehouse. 

h. On the Analysis Services tab, click the Step 4: Populate DW and Vision Cubes 
button to populate the data warehouse and the data cubes.  

This step will fail if the service account does not have rights to the data warehouse as 
assigned in step f. 
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i. If you purchased and activated the Vision Performance Management module, 
complete the following steps: 

1) In Vision, enter and save the settings on the Analysis Cubes Configuration form 
in Configuration » General » Analysis Cubes. 

2) In the Resource Kit, select the Cube configurations saved in Vision check box. 

3) In the Vision Resource Kit, click the Analysis Services tab (a sub-tab on the 
Database tab), and click the Step 5: Apply Cubes Configurations button to 
apply the settings in Vision Analysis Cubes Configuration to the data warehouse 
and data cubes. 

4) On the Analysis Services tab, click the Step 6: Populate DW and Vision Cubes 
button to populate the data warehouse and the data cubes. 

5. Use Notepad to open the \Vision\Analysis\ETL_2K8\Jobs\<database 
name>\VisionETL_Config.dtsconfig file on the Vision database tier server and ensure 
that the SQL cluster virtual name is used as the data source.  

See the file example below. If you connected to the SQL virtual name in Step 4b, it will be 
specified correctly. 

6. Copy the \Vision\Analysis\ETL_2K8\Jobs folder to the \Vision\Analysis\ETL_2K8 
folder on the other nodes in the cluster so that the refresh job will still function in the 
event of a fail-over.  

7. Perform a manual fail-over of the cluster, and run the SQL Agent Refresh Job to ensure 
that everything is working properly. 

Example of the contents of the VisionETL_Config.dtsconfig file 
The following example shows the contents of a VisionETL_Config.dtsconfig file (color-coded here 
for easier identification). 

 Data Source=<the Virtual name of the SQL Cluster> 

 First instance of Initial Catalog=<Vision database name> 

 Second instance of Initial Catalog=<Vision data warehouse name> 

 Third instance of Initial Catalog=<Vision analysis cube name> 

<?xml version="1.0"?> 

<DTSConfiguration> 

  <DTSConfigurationHeading> 

    <DTSConfigurationFileInfo GeneratedBy="ADSDELTEKCOM\sonnyrai" 
GeneratedDate="7/27/2007 4:29:36 PM" /> 

  </DTSConfigurationHeading> 

  <Configuration ConfiguredType="Property" 
Path="\Package.Connections[Vision].Properties[ConnectionString]" ValueType="String"> 

    <ConfiguredValue> Data Source=SQLCLUSTER\INST1; Initial 
Catalog=VisionDemo70;Provider=SQLNCLI10;Integrated Security=SSPI;Auto 
Translate=False;</ConfiguredValue> 

  </Configuration> 
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  <Configuration ConfiguredType="Property" 
Path="\Package.Connections[VisionDW].Properties[ConnectionString]" ValueType="String"> 

    <ConfiguredValue> Data Source=SQLCLUSTER\INST1; Initial 
Catalog=VisionDemo70DW;Provider=SQLNCLI10;Integrated Security=SSPI;Auto 
Translate=False;</ConfiguredValue> 

  </Configuration> 

  <Configuration ConfiguredType="Property" 
Path="\Package.Connections[VisionCubes].Properties[ConnectionString]" ValueType="String"> 

    <ConfiguredValue> Data Source=SQLCLUSTER\INST1; Initial Catalog=Deltek Vision 
Analysis – VisionDemo70;Provider=MSOLAP.4;Integrated Security=SSPI;Impersonation 
Level=Impersonate;</ConfiguredValue> 

  </Configuration> 

</DTSConfiguration> 

Troubleshooting 
“Chapter 3: Troubleshoot Analysis Cubes Deployments” on page 33 outlines the steps to 
troubleshoot failures in the SQL Agent Refresh Job by creating a SQL Agent output file. These 
steps also apply in a clustered environment, with the addition of the following for a clustered 
environment: 

 The SQL Agent job output files can be the output to the SQL Server cluster drives only. 

 The SQL Agent service account needs modify rights to the chosen directory for output 
files during the SQL Agent job execution. 

To ensure that this works properly, create a folder on one of the shared cluster drives. Be sure  
that the SQL Agent service account has modify rights to that folder.  

The following error displays in the SQL Agent Job output file if the SQL Agent service account 
does not have rights to the data warehouse database as specified in step 4f above.   

Error: 2012-07-30 16:47:55.88 

   Code: 0xC1060000 

   Source: Analysis Services Processing Task Analysis Services Execute DDL Task 

   Description: OLE DB error: OLE DB or ODBC error: Login failed for user 
'INETTEST2K3N\sqlclustersvc'.; 28000. 

End Error 

Error: 2012-07-30 16:47:55.88 

   Code: 0xC1120064 

   Source: Analysis Services Processing Task Analysis Services Execute DDL Task 

   Description: Errors in the high-level relational engine. A connection could not be made 
to the data source with the DataSourceID of 'VisionDW', Name of 'VisionDW'. 

End Error 
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Appendix B 

Steps to Create a Scalable Analysis Cubes Deployment 
This Appendix outlines the manual steps necessary to scale out your Analysis Cubes 
deployment. Refer to the end of this appendix for instructions on updating your Analysis Cubes 
Scalable Deployment necessary for an updated Vision release or when cube related updates are 
included in a Cumulative update. 

The following terminology will be helpful in understanding how scalability is achieved. 

Abbreviation Meaning Description 

Vision DB Vision Database 
Server 

This server hosts the Vision transaction 
database. 

Vision DW Vision Data 
Warehouse 

This is a secondary database hosted in SQL 
Server which houses intermediate data from your 
Vision database which has been processed and 
transformed by the SQL Integration Services 
Packages via an ETL process. 

Vision ETL Vision Business 
Logic Extract, 
Transform, and Load 

Vision ETL business logic is run by a SQL Server 
Agent job created by the Resource Kit. 

Vision Agent SQL Server Agent 
job 

This job is scheduled to refresh the Data 
Warehouse and Analysis Services data nightly by 
default. 

Vision AS SQL Server Analysis 
Services 

Project and General Ledger OLAP Cubes. 

 

The following configurations are supported: 

Configuration Server 1  
(Vision 
DB Tier) 

Server 2  
(Vision 
DW Tier) 

Server 3  
(Vision 
AS Tier) 

Notes 

     

Option #1  
Non-scalable 
Single Server 
installation 

Vision DB 

Vision DW 

Vision ETL 

Vision 
Agent 

Vision AS 

N/A N/A This is the default configuration where 
all components exist on the same 
server. The Resource Kit is run from 
the Vision DB tier. The steps in this 
appendix are not necessary for this 
configuration. 
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Configuration Server 1  
(Vision 
DB Tier) 

Server 2  
(Vision 
DW Tier) 

Server 3  
(Vision 
AS Tier) 

Notes 

Required 
Services 

SQL 
Server  

SQL 
Server 
Agent  

SQL 
Server 
Integration 
Services  

SQL 
Server 
Analysis 
Services  

 

N/A N/A  

 

Option #2 
Two-server 
scalable 
configuration 

Vision DB Vision DW 

Vision 
ETL 

Vision 
Agent 

Vision AS 

N/A In this configuration all components 
except the Vision DB are moved to a 
second server. The Resource Kit is 
run from the DW Tier. 

Required 
Services 

SQL 
Server  

 

SQL 
Server  

SQL 
Server 
Agent 
Service 

SQL 
Server 
Integration 
Services 

SQL 
Server 
Analysis 
Services 

N/A  
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Configuration Server 1  
(Vision 
DB Tier) 

Server 2  
(Vision 
DW Tier) 

Server 3  
(Vision 
AS Tier) 

Notes 

Option #3 
Three-server 
scalable 
configuration 

Vision DB Vision DW 

Vision 
ETL 

Vision 
Agent 

Vision 
AS 

In this configuration the Vision AS is 
moved from the Vision DW to a third 
server. The Resource Kit is run from 
the DW Tier. 

Required 
Services 

SQL 
Server  

 

SQL 
Server  

SQL 
Server 
Agent  

SQL 
Server 
Integration 
Services  

SQL 
Server 
Analysis 
Services  

 

 

Prerequisites for Scalability 
 Ensure that you have the necessary SQL Server licenses for your deployment. Refer to 

the Microsoft SQL Server licensing guidelines or talk to your licensing representative if 
you have any questions. 

 The Edition of SQL Server of the DW/AS or AS servers can be different from that used 
for the Vision Transaction Database server. Note, however, if you have the Enterprise 
Edition of SQL Server for your Vision Transaction Database server and deploy Standard 
Edition for the DW/AS or AS server, you will not have access to the functionality limited 
by Standard Edition (refer to the section Microsoft SQL Server Edition Dependencies 
earlier in this guide for more information).  Conversely, if your Vision Transaction 
Database Server is Standard Edition and you deploy the Enterprise Edition as the 
DW/AS or AS server, you will gain this functionality. 

 Ensure that you have installed the Vision Database tier installation on the Vision DB 
server but have not configured Vision Analysis Cubes.  

 Ensure that you have the necessary and supported SQL Server services installed on the 
various servers depending on your deployment model (refer to the chart above for 
information). 

 The Resource Kit prerequisite checks (Step #1 in the Resource Kit) are not 
performed in scalable configurations. The Resource Kit includes new scalability 
options; however, those options are not available when the Resource Kit is run from 
the Vision Database tier. You must follow the steps below to set up the Data 
Warehouse tier and run the Resource Kit from there. 

To create a scalable configuration, complete the following steps: 
1. If you have not already done so, install the Vision database tier installation on your Vision 

database server including any applicable Cumulative Updates. 
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2. If you have any existing Vision Analysis Cubes deployment on your Vision database 
server delete the following as you will need to rebuild the cubes from the Data 
Warehouse tier : 

a. SQL Database - <VisionDatabase>DW where <VisionDatabase> is the name of your 
Vision transaction database. If you are using a culture other than English US the 
database will be named <VisionDatabase>DW_<Culture> 

b. SQL Agent Job – “Refresh <VisionDatabase> <Culture> DW and Cubes” 

c. SQL Analysis Database – “Deltek Vision Analysis - <VisionDatabase>” 

d. Database job folder – <VisionDatabase>_<Culture> folder from <Drive>:\Program 
Files\Deltek\Vision\Analysis\ETL_2K8\Jobs 

3. Using the SQL Server installation media, install the appropriate SQL Server components 
on the Vision DW tier (and Vision AS tier if implemented a three-server scale out 
deployment) as indicated in the chart above.  Be sure to apply the supported service 
packs and cumulative updates on all servers. 

4. Copy the Vision folder structure from the DB tier to the DW tier:   

Copy <drive>:\Program Files\Deltek folder to the <drive>:\Program Files folder on the 
Vision DW Tier 

5. Create the required Environment Variables on the Vision DW tier by importing the registry 
file below: 

a. From the copied folders in Step 4 above, locate the \Deltek\Support\Scripts folder. 

b. If the default installation folder is other than c:\Program Files, edit the 
cube_environment_variables.reg.txt with Notepad (use Run as Administrator). If no 
editing is necessary, go to Step 5e. 

c. Modify the following as appropriate for the correct path (do not remove the double 
slashes (\\) in the path): 

"VisionETL_Root_Dir"="C:\\Program Files\\Deltek\\Vision\\Analysis\\ETL_2K8" 

d. Save your changes and exit Notepad. 

e. Rename cube_environment_variables.reg.txt to cube_environment_variables.reg. 

f. Double-click the .reg file to import its contents into the registry. 

g. After the import completes, restart the computer to initialize the changes. 

6. Create the required Vision registry entries on the Vision DW tier by importing the registry 
file below: 

a. From the copied folders in Step 4 above, locate the \Deltek\Support\Scripts folder. 

b. If the default installation folder is other than c:\Program Files, edit the 
VisionDW.reg.txt with Notepad (use Run as Administrator). If no editing is necessary, 
go to Step 6e. 

c. Modify the following as appropriate for the correct path (do not remove the double 
slashes (\\) in the path): 

"InstallDir"="C:\\Program Files\\Deltek\\Vision" 

d. Save your changes and exit Notepad. 

e. Rename VisionDW.reg.txt to VisionDW.reg. 

f. Double-click the .reg file to import its contents into the registry. 
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7. Make sure the following service accounts permissions are in place: 

a. The SQL Agent service account (on the Vision DW tier) needs dbo rights to the 
Vision transaction database (on the Vision DB Tier) in order to execute the linked 
server queries (see Step 8). 

b. The Analysis Services service account needs dbo rights to <Vision>DW database 
(add this after Step 2). 

8. Create a linked server on the Vision DW server pointing to the Vision DB server: 

 

If your servers have a hyphen (-) in the name (for example, Vision-DBServer) you 
need to create a SQL Server Alias on the Vision DW and ensure that you log in to the 
Vision DB server using the Alias when you use the Resource Kit (see Step 9a). 

If your servers were initially configured using Named SQL Instances (for example, 
Server\Instance), do not create use SQL Aliases when creating the linked server or 
when logging in or specifying the DW Server and AS Server entries in the Resource 
Kit. 

a. Open SQL Server Management Studio on the Vision DW Tier. 

b. Select Server Objects and right-click Linked Servers. 

c. Select New Linked Server. 
d. Enter the name of the linked server and select SQL Server as the Server Type. 

e. On the Security page, change the radio button for Be made using the login’s 
current security context. 

9. Run the Resource Kit on the Vision DW Tier (<drive>:\Program 
Files\Deltek\Vision\Support\ResourceKit\DeltekVisionResourceKit.exe). Be sure to right-
click the executable and select Run as Administrator. 
a. When you click the database tab and you are prompted to authenticate, enter the 

Vision DB Tier server name. The DWTier=1 reg key (Step 6) will provide a message 
box to remind you of this. 

 Scalability options will not be present unless the DWTier=1 reg key exists on the 
Vision DW server. 

 The Data Warehouse or Analysis Services servers fields will be grayed out 
until you select a database and language. 

 Step #1 will be grayed out when in scalability mode. 

b. Select the Vision Database for BI from the drop-down list. 

c. Select the Language from the drop-down list. 

d. Enter the names of the Data Warehouse and Analysis Services Server in the fields at 
the top of the page. 

e. Follow the remaining steps outlined in Chapter 2 of this document to deploy the 
Analysis Cubes. 

Steps to Update an Analysis Services Scalable Deployment 
As with the initial deployment, updates to the Analysis Cubes Scalable Deployment for new 
Vision releases or Cumulative Updates that include cube related fixes is a manual process.   
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To update your DW Tier and rebuild the Analysis Cubes, complete the following steps: 
1. Install the Vision release upgrade or Cumulative update to your Vision Database Tier. 

2. Rename the Vision folder on your DW Tier server to Vision and the current date (for 
example, Vision_112114). 

3. Copy the updated Vision folder on the Database Tier to the DW Tier. 

4. Follow the sub-steps in Step 9 above to rebuild the Analysis Cubes. 

5. When prompted to overwrite the existing cube configuration in Step 2, click OK. 

6. Follow the remaining steps outlined in Chapter 2 of this document to deploy the Analysis 
Cubes. 

 



 

 

 

Deltek is the leading global provider of enterprise software and information solutions for government 
contractors, professional services firms and other project- and people-based businesses. For decades, we 
have delivered actionable insight that empowers our customers to unlock their business potential. 20,000 
organizations and millions of users in over 80 countries around the world rely on Deltek to research and 
identify opportunities, win new business, recruit and develop talent, optimize resources, streamline 
operations and deliver more profitable projects. Deltek – Know more. Do more.®  
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